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About This Guide 
This User Guide is designed to ease your way into using the AT&T Connect® Participant 
Application for PC. Enjoy! 
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1. INTRODUCTION 

The Application 
The AT&T Connect® Participant Application for PC is a full-featured virtual conference space that 
lets you easily communicate using voice and data through the internet. The Participant 
Application window is automatically displayed upon connecting to an AT&T Connect conference. 
A host uses both the whiteboard and verbal conversation as the two main tools for 
communicating with participants during a conference. 

 
Figure 1–Participant Application  



  Participant Application for PC User Guide 

Product Version: v9.5 
Published:  03/05/2013 10 

Note: The AT&T Connect Participant Application is fully accessible according to Section 508 of 
the US Rehabilitation Act. For more information, see Appendix B and Appendix C. 

The Users 
Participants, presenters, hosts and co-hosts work with the features of the Participant 
Application during an online conference. Some features can be used by everyone in the 
conference while others are allowed only for hosts, co-hosts and presenters.  The roles of the 
participants are described below.  

Participant 
Any person who takes part in an AT&T Connect conference is a participant. Participants can 
speak in a conference, insert files to the Conference Material tab, write on the whiteboard, and 
do much more, as described in the following sections of this User Guide.  

Presenter 
A presenter is any participant with presenting rights and who currently has “control” of the 
conference. Presenters can perform such actions as loading files onto the whiteboard, switching 
the conference speaking mode, initiating application sharing, performing Web tours, polls and 
surveys. In addition, presenters can invite additional participants to the conference, expel 
participants from the conference, lock the conference, and do much more, as described in the 
Host/Presenter sections of this User Guide.  

Presentation rights are often passed among participants as each one presents materials to the 
group. The “Presenter” title appears next to the presenter’s name in the Participants List. 

Host 
A host is the person who initiates the conference, defines the initial conference materials in the 
Materials tab and initially has the presenting rights. The host can give and take the presenting 
rights from a presenter at any time. The “Host” title appears next to the host’s name in the 
Participants List. A host can also assign co-host status to a participant. 

Co-Host 
A host can promote a participant to co-host. Co-hosts have the same privileges as the host and 
typically help the host to conduct the conference.  A co-host can give and take presenting rights 
if the host leaves the conference. The “Co-Host” title appears next to the co-host’s name in the 
Participants List. 

Note: The first participant to enter a conference and who connecting with their computer PC is 
automatically assigned presenting rights (phone-only participants can be the first to enter a 
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conference but will not receive presenting rights). If the host then joins the conference, the host 
can take the presenting rights from the relevant participant. 

Types of Conferences 
When scheduling a conference, a host chooses the type of conference in the myAt&t 
application.  For more information, see AT&T Connect® myT&T User Guide. 

A conference can be one of the following: 

• iMeeting—(default) allows multiple participants to take a pro-active role in the conference. 
All participants typically have similar conference rights and privileges. An iMeeting has one 
host, one presenter, and can have multiple co-hosts. 

• eLearning—a moderated conference in which a teacher-student relationship exists between 
the presenter and participants. In eLearning conferences, participants can view the 
Participants list. 

• Webinar—a moderated conference in which the Participants list is hidden and sending 
notes among participants is usually prohibited. 

Hosts/presenters can control conference settings when scheduling a conference, or during the 
conference itself by clicking Conference > Conference Settings. For more information, see 
Changing Conference Settings. 

Speaking Modes 
AT&T Connect conferences can be set so that participants converse in one of two speaking 
modes:  

• Voice Activated mode—enables conference participants to start speaking simultaneously at 
any point during the conference. This mode provides a more natural discussion mode, giving 
the impression of an “open floor” environment that is typically found in conventional 
telephoned-based conference calls. 

• Broadcast mode—permits only specific users to speak. Typically this mode is used for 
lecture-type presentations or for an “expert forum”. In this mode, the focus is on the 
presenter and the materials being shared with the group. All participants are in the muted 
and locked state except for the broadcast group. For more information, see Enabling 
Broadcast Mode. 

Number of Participants 
All types of AT&T Connect conferences are limited to 250 participants. 
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2. INSTALLING THE APPLICATION 

System Requirements 
Participants and host/presenters should ensure that their computers meet the basic minimal 
requirements before they install the Participant Application. For information on the system 
requirements, please see AT&T Connect® System Requirements for End Users. 

Installing the Participant Application 
You can install the Participant Application from your email invitation to the conference or from a 
CD. 

Installing from the Web 
You may receive an email invitation to an AT&T Connect conference before you have installed 
the Participant Application.  

When you click the links in the email invitation, AT&T Connect prompts you to install the 
Participant Application. During installation, you may receive security prompts from Microsoft 
Internet Explorer® – accept these prompts to download and run the Participant installer. This 
automated conference entry depends on your organization’s IT policy, and may not be available 
in your organization. 

Installing from a CD 
The Participant Application is also available on CD. Simply insert the AT&T Connect CD and the 
user interface automatically comes up. Choose Install Applications/Participant Application.  

To install from a CD: 

1. Close other Windows applications on the machine.  

2. Double-click the ATT_Connect_Participant.msi file of the installation package. Accept the 
software license terms to begin installation. A progress bar tracks the installation process. 
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3. When installation is complete, click Finish to exit the setup. The Participant Application is 
now ready for use. 
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3. JOINING A CONFERENCE 

Joining as a Participant 
You access a conference via an email invitation sent to you by the host. You can also access the 
conference via an Outlook® calendar entry or Lotus Notes® calendar entry (if installed). For 
more information, see the AT&T Conferencing® Add-in for Microsoft Outlook® 2007/2010 User 
Guide and the AT&T Connect® Lotus Notes® Add-in User Guide.  

To listen and speak in the conference you can use your microphone and speakers or headset (voice 
over computer) or connect with your telephone. As a participant, you can also connect to the 
conference with only your telephone. 

To join the conference: 

1. Click the link to the conference in your email invitation. 

 
Figure 2–Link in Email Invitation 

–or– 
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In the relevant calendar section, double-click on the appointment and in the displayed 
appointment window, click on the conference link. 

If this is the first time you are connecting to a conference, a window opens for selecting the 
type of Participant Application you wish to use (Windows-based or Web-based). 

 
Figure 3–Select the Participant Application Window  

2. Select Windows-based or Web-based, and check Remember me if you wish to use this type 
of application for future conferences. For more information on the Web-based application, 
see Using the Web Participant in an AT&T Connect® Web Conference Quick Start Card. 

3. Click Continue. This opens a window for providing your name and email address. If you have 
not yet installed the application, you will be asked for permission to do so at this point. 
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Figure 4–Your Details Window for Participants 

4. Enter your name and email address and check Remember me if you want your details to be 
automatically filled in the next time you open the Participant Application. 

5. Click Join. After a few moments in the “waiting room,” the Participant Application opens for 
the conference to begin. 

Note: As the Participant Application opens, a Thank You window appears and immediately 
moves to the background. If you unintentionally close the application, clicking the Click to 
re-enter the conference link in the Thank You window reconnects you to the conference. 

Joining as the Host 
When connecting to a conference as the host, you need to enter your username and password. 

1. In the Your Details window, select I am the host. The fields are changed for entering the 
host’s details.  
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Figure 5–Your Details for Hosts 

2. Enter your details and check Remember me if you want your username and password to be 
automatically filled in the next time you open the link to your conference room. 

3. Click Join. After a few moments in the “waiting room”, the Participant Application opens for 
the conference to begin. 

Connecting Your Audio 
The first time you enter a conference, the Choose Audio Device window is displayed for you to 
choose how you wish to connect your audio (Call Me, Dial in or Voice-over-Computer). 

 
Figure 6–Choose Audio Device Window 
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Notes:   

• Check Remember my choice if you wish the option you select to be used for future 
conferences. You can select a different option during a conference, as described in Changing 
your Audio Device during a Conference, and you can set a preferred default audio device for 
future conferences, as described in Defining a Preferred Audio Device. If you do not check 
Remember my choice, the Choose Audio Device window will be displayed in future 
conferences. 

• If a conference does not allow the use of a headset or a microphone and speakers (voice 
over computer), the Choose Audio Device window is not displayed and you enter the 
conference without being prompted to select an audio device. 

Using the Call Me Option 
If company policy allows, you can request that the AT&T Connect TeleConference Service call 
you.  

1. Click Call Me in the Choose Audio Device window to open the Call Me window. 

 
Figure 7–Call Me Window 

2. Enter your country code, area code and phone number and click OK. AT&T calls your 
number and prompts you to join the conference 

Notes:   

• You can also access the Call Me option from within a conference (for example, if you need 
to reconnect your audio): 

• In the Participants list, right-click your name and choose Call Me…. 
• In the Audio/Video menu, click Call Me…. 
• In the toolbar, click the Audio button. 
• In the Telephone Connection Instructions window, click the Call Me button. 

• The Call Me feature may not be enabled outside North America. 

Dialing in to the Conference 
Dial in to the conference according to the Dial In instructions. 

1. In the Choose Audio Device window, click Dial in to open the Telephone Connection 
Instructions window. 
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Figure 8–Telephone Connection Window (Host) 

2. Dial the relevant number shown (according to your location). 

3. When prompted, use your telephone keypad to enter the access code and then follow the 
operator’s instructions 

Note:  You can also access the dialing instructions from within a conference (for example, if you 
need to reconnect your audio) by clicking Telephone Connection Instructions the Audio/Video 
menu.  

Using a Headset (Voice-over-Computer) 
Click the headset icon if you wish to use a headset or the microphone and speakers attached to 
your computer (voice-over-computer).  

Already Connected by Phone? 
If you are already connected to the conference by phone, dial the participant code displayed in 
the Choose Audio Device or Telephone Connection Instructions windows. Doing so will display 
your name in the Participants list. 
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4. VIEWING THE PARTICIPANT APPLICATION 

What Do You See in the Participant Application? 
Welcome to the conference! This section describes the user interface of the Participant 
Application. 

 
Figure 9–Participant Application User Interface 
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Participant Window Components 
The Participant Application window consists of a single full screen window that is divided into 
resizable sections. Upon launching, the window appears in its “maximized” mode—it takes all of 
the available screen resolution, regardless of the resolution settings (for example, 800x600 or 
1024x768). 

The Participant window includes the following components: 

• Title bar: Indicates the conference name (for both live and recorded conferences) and the 
Meeting Room ID. 

• Whiteboard: Lets participants view the contents of materials loaded by the presenter during 
a conference, including Word, PowerPoint and Web sites. The split bar enables resizing the 
whiteboard as required. Alternatively, the Whiteboard button expands the whiteboard by 
removing the Participants list and the title and menu bars of the application window. For 
more information, see Viewing the Whiteboard. 

• Participants list: Displays the list of participants in the conference (including each 
participant’s live status). Participants can communicate with other participants during most 
conferences and view who is speaking. 

 
Figure 10–Participants List 

The participant counter is displayed in the Participants tab, above the Participants list. A 
role is displayed next to each user, i.e., Mark Richards (Host). Hosts, presenters and co-hosts 
are displayed as a group at the top of the list (under the Presenters heading), and the 
participant group is displayed underneath. The Participant's list is sortable according to the 
following columns: Emoticons, Name, Audio, Load, and Response. Each group (Presenters 
and Participants) are sorted separately. In addition, a search field allows searching for 
participants as you type. 
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• Toolbar: Provides quick access to the following Participant Application features:  

• Request permission to speak (you can also express your emotions with alternative 
emoticons, as described in Inserting Files. 

• Send notes 
• Temporarily “step out” of the conference.  
• Change the whiteboard mode (for example, enlarge).  

For more information, see Toolbar Buttons. 

• Notes tab: Displays the notes passed to you by others. You can also send notes. For more 
information, see Using Notes.  

• Materials pane: Includes four tabs (Materials, App Sharing, Web and Polls), via which you 
can work with Conference Materials, start and end Application Sharing and Web Tours, and 
initiate Yes/No and OK polls.  

• Status panel: Provides an ongoing display of the current status of the conference audio and 
connection. For more information, see Status Messages in the Status Panel.  

Note: You can open a full status report by clicking Conference Status from the Conference 
menu 

• Sound settings: These settings can be adjusted as required (only when audio is via your 
computer).  

• Conference Materials Status indicator: Displays the status of Conference Materials with one 
of the following values:  

• Downloading… 
• Preparing… 
• Ready to Use 
• Error 

• Getting Started Page: Displays general information about the application to the participant. 
For more information, see Getting Started Page.  

Getting Started Page 
When you join a conference, the Participant Application window opens with a Getting Started 
page displayed on the whiteboard. The Getting Started page provides tips and tricks for using 
the Participant Application. Under the tips is a link to the AT&T Connect Quick Start Cards with 
simple instructions for using the basic features of the application. 

To display the tips: 

• Click on the item to open the tip. 
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Figure 11–Getting Started Page 

“Did You Know?” Banner 

At the bottom of the Getting Started Page is the Did you know? banner. Clicking the banner 
displays all the operating systems that support AT&T Connect. Clicking each icon opens a 
webpage with information on running AT&T Connect on the selecting operating system. 
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Figure 12–Getting Started Page with Open Banner 

Upgrade Notification Area 

When Customer Care wishes to inform participants of upcoming application upgrades, the 
Getting Started page displays a yellow bar at the top of the whiteboard with the relevant text.  

 
Figure 13–Upgrade Information 
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Notes:  

• You can access the Getting Started page any time during the conference by Select Getting 
Started from the Help menu in the menu bar. 

• You will not see the Getting Started page when you join the conference if a participant has 
already activated the whiteboard (for example, if a participant is using the drawing tools). 

Understanding Icons and Status Messages 
This section describes the Participant Application icons and status messages. 

Toolbar Buttons 

A convenient set of buttons enables you to initiate most operations directly from the Participant 
Application toolbar. 

 
Indicates to your presenter that you want to ask a question or make a comment. Note: This icon is the 
default emoticon and will change according to the emoticon selected. See Using Emoticons for a 
description of all available emoticons. 

 
Sends a note to other conference attendees, either to ask a question or make a comment. 

 
Enables you to inform the presenter that you are temporarily “stepping out” of the conference. This 
button toggles to Step In which you click when you wish to re-enter the conference. 

 
Enables you to view the whiteboard in full-screen mode, with or without the toolbar. Also enables you to 
view the actual size of a shared application or to fit the shared application to the whiteboard. 

 
Displays the Choose Audio Device window, from which you can select the audio device you want to use 
during the conference. 
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Mutes your microphone. This button toggles to Unmute which you click when you wish to start speaking 
again. 

 
During conferences, if video is allowed, enables users with a webcam to start transmitting their video at 
any time. If all the video windows are “busy” by other users, a relevant message is prompted to the user. 
 

Participants List Icons 

The icons in the Participants list give you information about the conference participants. The 
icons are displayed in columns, which include the participant’s status, audio status, video status, 
application sharing status, and response to polls. The icons are described below. 

Status Icons 

Status icons indicate how the participant is connected to the conference. These icons can also 
be emoticons that the participant has chosen to emphasize a certain feeling or state. 

 
The participant is connected to the conference with his/her computer. 

 
The participant is using a phone to listen and speak in the conference while using his/her computer to 
view content on the whiteboard. 

 
The participant is connected with a phone only and will not be able to see any of the contents displayed 
on the whiteboard. 

 
The participant is using the Web Participant Application. 

 
The participant is using the Web Participant Application and a phone. 
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The participant is using a mobile application. 

 
The participant is connected with Voice-over-Computer (VOC). 

 
The participant is connected and is requesting to speak. 

 
The participant is happy. 

 
The participant is unhappy. 

 
The participant agrees. 

 
The participant disagrees. 

 
The participant understands. 

 
The participant is confused. 

 
The participant requests to go faster. 

 
The participant requests to go slower. 

 
The participant is applauding. 



  Participant Application for PC User Guide 

Product Version: v9.5 
Published:  03/05/2013 28 

 
The participant cannot hear. 

Note: When you or another participant steps out of the conference, the icon is colored grey.  

 
Figure 14– Grayed Participant icon 

Note: When you, or another participant, use emoticons, your icon in the Participants list will be 
replaced by the selected emoticon. For more information on emoticons, see Using Emoticons. 

Audio Icons 

Audio icons show a participant’s audio status. Only the host and presenter can see if a 
participant is muted, or muted and locked. For more information, see Muting and Locking 
Participants. 

 
Audio is not available. 

 
Audio is available. 

 
The participant is speaking. 

 
The participant is muted. 

 
 The participant is muted and locked. 

Video Icons 

Video icons show whether or not a participant’s video is on or off. 

 
Video is on. 

 

Video is off. 
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 Icons Displayed to the Presenter 

In addition to the icons that are displayed for participants, hosts and presenters can see icons 
for polling results, application sharing and the mute status of a participant. 

Polling Icons 

A letter or number displayed to the left and above the participant icon indicates participants’ 
answers to the presenter’s latest questions or polling requests (a blank space means no 
response has yet been received). Each new question that the presenter sends blanks out this 
space. 

 
The answer to the poll is Yes. 

 
The answer to the poll is No. 

 
The answer to the poll is OK. 

 
The participant abstained from the poll. 

<number> 
The answer to the poll is <number>. 

For more information, see Initiating Questions, Polls and Surveys. 

Sharing Icons 

A graphic symbol displayed near the participant icon indicates the status of the last item the 
presenter loaded onto the whiteboard. This space will be blank after the Participant Application 
successfully loads the item. These icons are described below. 

 
Materials are being downloaded. 

 
The materials downloaded successfully. 

 
The downloading of materials failed. 
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The participant has remote control. 

For more information, see Viewing a Shared Application. 

Status Messages in the Status Panel 

The Status Panel is located to the right of the tools in the toolbar.  

 
Figure 15–Status Panel 

It provides messages that describe the status of your connection, conversations and recordings.  

Table 1–Status Panel Messages 

Message Description 

Multiple Speakers More than one user is speaking. 

Meeting in Progress Indicates that the conference in progress. This message is displayed 
during the conference if nobody is speaking. 

You Are Speaking Indicates who the speaker is (you or the other participants). The name 
of the speaker with “On the Air” is displayed.  

Playing Recorded 
Conference 

The participant is playing back a recorded session. 

Stepped Out The participant has temporarily stepped out of the conference. 

 

Note: When connecting to a conference, no status message is displayed and Connecting to 
Conference is flashed in the Status Panel. When disconnected, no status message is displayed: 
the disconnected mode is indicated by “darkening” the Status Panel and displaying Connection: 
None. 
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5. USING AUDIO OPTIONS 

Speaking in a Conference 
As a regular participant in a Voice Activated conference (without presenting rights), simply start 
speaking. The Participants list and Status Panel indicate that you are currently speaking. 

Note: Echo and background noises are reduced to a minimum, while any pauses in your 
conversation are reflected in the Participants list and status panel. 

Manually Muting/Unmuting Your Microphone 
You may find it convenient to work with your microphone muted and then unmute your 
microphone whenever you wish to speak. This will ensure that the other participants only hear 
what you want them to hear.  

To mute your microphone: 

From the Participants menu, click Mute. 

–or– 

Click the Mute button in the toolbar.  

 
Figure 16–Mute Button 

The Mute button toggles to Unmute. 

 
Figure 17–Unmute Button 

In the Participants list, when you are muted a muted microphone icon is displayed next to your 
name. This icon is displayed only to you and the presenter. 
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Figure 18–Muted Microphone Icon 

To unmute your microphone: 

Click Unmute from the Participants menu or the Unmute button. 

Note: The host/presenter can mute and lock your microphone, after which you will not be able 
to speak. 

Automatically Muting your Microphone 
All users can define whether their microphone is muted when they enter the conference. These 
settings are defined in the Audio tab of the Application Options window, as described below, 
and can be defined prior to or during the conference itself. 

To mute your microphone: 

1. From the Conference menu, select Application Options. In the displayed Application 
Options window, click the Audio tab. 

2. In the Automatic Muting section, select:
      "When I first enter a Voice Activated iMeeting" if you want your microphone 
       automatically muted when joining a voice activated conference. This option is 
       especially useful in preventing other participants from hearing comments or noise not 
       intended for transmission.

3. Click OK to apply the settings you selected. 

Tip: You can also define whether or not the CTRL key is used to activate your microphone; in the 
Microphone section of the Audio tab, select the Use the CTRL key to activate my microphone 
checkbox if you want to use the CTRL key. 

If you do not want to use the CTRL key (for example, you may want to copy and paste via the 
keyboard, CTRL+C or CTRL+V, during the conference), make sure that this checkbox is not 
selected. As a result, when you want to speak you must click the Muted button. 

Adjusting Your Microphone and Speaker/Headset 
During a conference, you can adjust the microphone and speaker/headset settings by moving 
the slide bars up and down as required. The settings you define are actually the settings of your 
Windows audio mixer (usually accessed from the speaker icon in the Windows System tray). 
These settings remain the same for any other subsequent conferences. The microphone settings 
are adjusted dynamically during the conference.  

Tip: During a live conference, a volume level to the right of the Status Panel indicates the 
loudness level of your microphone. 



  Participant Application for PC User Guide 
 

Product Version: v9.5 
Published:  03/05/2013 33 

Note: If you are currently using your telephone for your conference audio, Audio via Telephone 
is displayed instead of the volume controls; you cannot modify the microphone and 
speaker/headset sound levels. 

To adjust your speaker and/or headphones settings: 

1. Directly below the Status Panel, click the speaker’s volume button to open the slider. 

 
Figure 19–Speaker Volume Button 

 
Figure 20–Adjusting Speaker and Headphone Settings 

–or– 

From the Audio/Video menu, select Adjust Speaker Volume to open the slider. 

2. Adjust the slider to the desired volume. Adjusting the slider simultaneously adjusts the 
volume-level percentage displayed on the volume-adjust button. 

To adjust your microphone settings: 

1. Directly below the Status Panel, click the microphone’s volume button to open the slider. 

 
Figure 21–Microphone Volume Button 

–or– 

From the Audio/Video menu, select Adjust Microphone Volume to open the slider. 

2. Adjust the slider to the desired volume. Adjusting the slider simultaneously adjusts the 
volume-level percentage displayed on the volume-adjust button. 

Automatic Gain Control: The Participant Application automatically monitors your audio signals 
and those of other participants, and adjusts the volume levels during a conference. Even if you 
manually set your microphone volume level, it may change during the conference. 
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Defining a Preferred Audio Device 
Typically, you can determine which type of audio device (voice-over-computer device or 
telephone) you wish to regularly use in future conferences.  

Note: This preference setting is only used during the initial entry process to a conference and 
can be changed at any time. If, however, you change this setting during a conference, it will only 
take effect when connecting to a future conference.  

To define a preferred audio device: 

1. From the main menu, select Conference and then Application Options to open the 
Application Options window. 

2. Select the Audio tab. 

3. In the Preferred Audio Device section, select from one of these options: 

• Microphone and speakers, or headset, attached to my computer—ensures that you 
listen and speak during conferences with your voice-over-computer device.  

• Telephone—ensures that you listen and speak during conferences with your telephone. 
Select the way you wish to connect your telephone, with the Dial In or Call Me options. 

• No preference–ask me each time I enter a Conference—the default setting and ensures 
that the Choose Audio Device window is displayed each time you connect to a 
conference. 

4. Click OK. 

Note: The audio setting for the conference may not allow you to define your own preference. 

Changing your Audio Device during a Conference 
Typically, you can change your audio device during a conference. For example, you may have 
been using a voice-over-computer device and wish to switch to a telephone, or vice versa.  

To switch your audio device: 

1. Select Choose Audio Device… from the Audio/Video menu or click the Audio button from 
the toolbar. These actions open the Choose Audio Device window. 

2. Choose Call Me, Dial in or Voice over computer. 

3. Check Remember my choice if you wish to use the device the next time you participate in a 
conference. 

4. Click Close. 

For more information on the audio options, see Connecting Your Audio. 

Note: Depending on the conference’s audio setting, and/or your preferred audio device setting, 
the audio device may be automatically determined when you connect to the conference (and 
therefore cannot be changed). 
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Using your Telephone in a Conference 
You can communicate in the conference using various key characters on your phone keypad. 
The keys and their descriptions are displayed in Table 2. 

Table 2–Keys for Use in a Conference 

Key Description Who Can Use It 

*# Get list of conference call commands Host/Participant 

# Exit list of conference call commands Host/Participant 

0 Request specialist assistance (toggle on/off) Host/Participant 

1 Dial out to add a participant Host 

2 Begin/End recording conferences Host 

3 Change conference Entry/Exit announcement: 
+2: Adds Entry/Exit tones 
+3: Silences Entry/Exit tones 

Hosts 

4 Lock/Unlock conference (toggle on/off) Host 

5 Count number of participants Host/Participant 

6 Mute/Un-mute line (toggle on/off) Host/Participant 

8 Continue current conference without host Host 

71 Turn Broadcast mode on or off (toggle on/off) Host 

74 Change host password (for current and future 
conferences) 

Host 

75 Change Entry/Exit options (future conferences): 
+2: Adds Entry/Exit tones 

Host 

76 Change starting conference without host (future 
conferences) 

Host 

77 Change continuing conference without host (future 
conferences) 

Host 

78 Mute all Host 

70 Unmute all Host 

 

Note: If you are a “Phone-only” participant, the following limitations apply:  

• You cannot receive presenting rights during a conference. 
• You cannot receive notes.  
• You cannot receive “remote control” over a shared application.  
• You cannot view the whiteboard. You cannot participate in tests or polls. 
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Reconnecting your Audio 
If your audio is disconnected while you are still connected to the conference, a message is 
displayed. Click OK and then select the device for reconnecting your audio (in the Choose Audio 
Device window). For more information, see Connecting Your Audio. 
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6. VIEWING THE WHITEBOARD 

Viewing Whiteboard Content 
The whiteboard occupies two-thirds of the window width by default, which you can resize using 
the split bar.  

You can display the whiteboard in full-screen mode, with or without the toolbar, as described 
below. 

To expand the Whiteboard to full screen-mode without the toolbar: 

1. Click the Whiteboard button in the Participant window toolbar >Full-Screen without 
Toolbar. 

 
Figure 22–Whiteboard Button 

—or— 

From the View menu, click Enlarge Whiteboard>Without Toolbar. 

The whiteboard is enlarged and the Participants list, title bar, toolbar, and menu bar are 
removed.  

2. To return the Participants window to its default mode, click Exit Full-Screen (the lower right 
corner) or press the Esc button on your keyboard. 

To expand the Whiteboard to full screen mode with the toolbar displayed: 

1. In the Participant window toolbar, click the Whiteboard button >Full-Screen with Toolbar.  

–or– 

From the View menu, click Enlarge Whiteboard>With Toolbar. 

The whiteboard is enlarged and the Participants list, title bar and menu bar are removed.  

2. Press the Esc button on your keyboard or select Exit Full-Screen from the Whiteboard menu 
to return the Participant window to its default mode with the Participants list displayed. 
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Figure 23–Exit Full-screen View 

Viewing a Shared Application 
Typically, when a presenter loads an application on the whiteboard, participants see it 
immediately.  If the presenter allows, participants can interact with the shared application, one 
at a time. 

When the presenter initiates application sharing, participants are notified with a message on the 
toolbar. 

 
Figure 24–Application Sharing in Progress 

When the presenter gives a participant temporary control over keyboard and mouse interaction 
with the application, the participant is notified in the “application sharing” message.  

 
Figure 25–Application Sharing with Participant in Control 

Note: For information on how a presenter shares an application, see Error! Reference source 
not found.. 

Adjusting the Size of a Shared Application 
You can view the shared application in its actual size (default view), or fit the application to the 
size of the whiteboard.  
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Figure 26–Actual Size of Shared Application (Default) 
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Figure 27–Shared Application Fit to the Whiteboard 

To fit the shared application to the whiteboard: 

1. From the View menu, select Adjust Shared Application Display>Fit to Whiteboard. 

2. Select Actual Size to return the application to its default size. 

Sharing your Desktop “Over the Shoulder”  
You may wish to share your desktop with the presenter for working together on your desktop 
application.  The other participants will be able to see your desktop as well.  

To request an “over the shoulder” session: 

• Send a note to the presenter, or raise your hand with a request to initiate the sharing of 
your application. 

Note: For details on what the presenter needs to do for viewing a participant’s desktop “over 
the shoulder”, see Sharing an Application “Over the Shoulder”. 
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Using Whiteboard Tools 
All users have access to the whiteboard drawing tools, unless the host/presenter disabled 
whiteboard access (in Conference Settings). The drawing tools appear in the Drawing toolbox on 
the toolbar and in the Whiteboard menu. 

 
Figure 28–Drawing Toolbox 

The tools are described below. 

 
Enables you to display a pointer on the whiteboard. You can modify the color of the pointer. Any other 
conference attendees will also see at what you are pointing. 

 
Enables you to type text on the whiteboard. You can define the font, size and color of the text. 

 
Enables you to select the type of shape to draw on the whiteboard, or to erase your drawing. 

 
Enables you to clear the current contents of the whiteboard (for presenters only). 

 
Enables you to define the thickness of the lines drawn when using the line or shape whiteboard tool. 

 
Enables you to define the color used when using any of the above-mentioned tools. 

Note: The other conference attendees can view whatever operations you are performing on the 
whiteboard. You can also save the whiteboard contents and use a “snapshot” of the contents as 
Conference Materials. For more information, see Saving Whiteboard Content. 

Pointing at your Display 
You can identify points on your display to others. Any other conference attendees will also see 
at what you are pointing.  
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To point at your display: 

1. To select the pointer for use on the whiteboard, click the pointer in the Drawing toolbox. 

 
Figure 29–Pointer Button 

–or– 

Click the Whiteboard menu>Annotation Tools>Pointer.  

You can also select a color for the pointer by clicking the arrow to the right of the color tool 
in the Drawing toolbox or clicking the Whiteboard menu>Color, and selecting the relevant 
color. 

 
Figure 30– Color Palette Button 

2. Move the cursor to the required location on the whiteboard, and then click the left mouse 
button. The pointer is displayed to the other participants/hosts. If you want to move the 
pointer to a different location, repeat this action or double-click on the pointer. The pointer 
remains where you double-clicked it and you can now point elsewhere. 

3. Select another tool, such as the text tool, to remove the pointer from the whiteboard. 

Tip: By default, the names of participants using the pointer are also displayed next to the 
pointer. To remove participant names, select Conference>Application Options and in the 
Other tab clear the Show participant name next to whiteboard pointer checkbox. 

Writing on the Whiteboard 
You can write text on the whiteboard in a variety of fonts, sizes and colors.  

To write text on the whiteboard: 

1. In the Drawing toolbox, click the Text button. 

 
Figure 31–Text Button 

–or– 

Click the Whiteboard menu>Annotation Tools>Text. 

Move the cursor to the position where you want to start typing in text. 

2. To select a font, size and font type for the text, in the Drawing toolbox, click Text button and 
then click the Font button. 

 
Figure 32–Font Button 
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–or– 

Click the Whiteboard menu>Font… 

You can also select a color for the font by clicking color palette button in the Drawing 
toolbox or clicking the Whiteboard menu>Color, and selecting the relevant color. 

3. Look at the Sample pane to verify that this is the text you want. 

4. Type in the text which is displayed on the whiteboard. 

Note: You must press Enter or click a new position on the screen to display the text to all 
participants. 

Drawing Lines and Shapes on the Whiteboard 
You can draw shapes on the whiteboard in many colors. The following shapes are available from 
the Drawing toolbox and the Whiteboard menu: 

 
Figure 33–Shape Buttons 

The thickness of the shape you are drawing can vary from 1 to 32 pixels. 

To draw shapes on the whiteboard from the Drawing toolbox: 

1. In the Drawing toolbox, select a thickness by clicking the Line button, and color by clicking 
the color palette. 

―or― 

From the Whiteboard menu, select Line Width and select the desired thickness. Then Select 
Whiteboard>Color and select the desired color from the color palette. 

2. Click the pencil button (this is the default—it changes according to your selection) to display 
the palette of available shapes and click the required shape button. 

 
Figure 34– Freehand Drawing Button 

 
Figure 35–Color Palette  

–or– 



  Participant Application for PC User Guide 

Product Version: v9.5 
Published:  03/05/2013 44 

Select Whiteboard>Annotation Tools to display the palette of available shapes and click the 
required shape button.  

The cursor turns into a cross with a shape icon below it. 

3. Move the cursor to the position where you want to start drawing. Click the mouse, keep it 
pressed while you are drawing, and release it when you are finished. 

4. To draw an identical shape, move the cursor to a new position and double-click. 

Tip: Hold down the Shift key to draw perfect squares and circles instead of rectangles and 
ellipses. 

Saving Whiteboard Content 
You can save the content of the whiteboard at any time during the conference. The contents are 
saved in .JPG format and, subsequently, can be used as part of any future Conference Materials. 

To save the whiteboard contents: 

1. From the Participant Application Whiteboard menu, click Save Whiteboard Content…. The 
Save As window is displayed. 

2. Define a name for the file (or leave as snapshot1) and click Save. The file is located by 
default in the Snapshots folder (under the AT&T Connect data folder). 
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7. USING NOTES 

From the Participant Application you can send a note to conference attendees, either to ask a 
question or make a comment.  

Sending a Note 
This section describes several ways to send a note to other conference attendees. 

Note: The Notes tab is displayed to both hosts and participants during any conference. 
Participants can reply to private notes sent to them but cannot reply to a public note.  

Tip: The Notes tab can be resized as required, by dragging the split bars to the left and below 
the tab.  

To send a note: 

1. From the toolbar, click the note icon.  

 
Figure 36–Note Icon 

–or– 

In the Participants list, right-click the row of the relevant participant and in the displayed 
popup menu, select Send Private Note. 

–or– 

When the participant to whom you want to send the note is selected in the Participants list, 
from the Participants menu click Actions on + participant’s name>Send Private Note. 

2. In the displayed New Note window, select the relevant attendee from the Send Note to 
dropdown list. Note that if you right-clicked on the attendee or used the option from the 
Participants menu (as described in Step 1), this attendee is by default selected. You can also 
select All to send a public note to all attendees. 

3. Type your message and click Send. The window automatically closes. 
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To send a note via the Notes tab (Chat Style): 

1. From the Notes tab, select the relevant attendee from the To dropdown list. Select All to 
send a public note to all attendees).  

Note: The Notes tab is displayed slightly differently for presenters and participants. 

2. Type your message and click Send. If you defined your display style as Chat, the note is 
immediately displayed in the Notes transcript box. (The display style can be Chat, Popup or 
Inbox. For more information, see Defining Note Settings.) 

Tip: When working in the Chat style, you can force line breaks by pressing Ctrl + Enter on 
your keyboard. 

Receiving a Note 
Any time during the conference you can receive notes from others in the conference. Depending 
on the display style you have chosen (as described in Defining Note Settings), the display of 
incoming notes will be different. This section describes receiving notes in the Chat, Popup and 
Inbox styles. 

Regardless of the style, when receiving a new note the icon on the Notes tab flashes for 5 
seconds (if defined accordingly, see the Defining Note Settings section for further information). 
In addition, a Notes Unread message is displayed, according to the number of notes you have 
yet to read. Unread messages are also displayed in bold text in the Chat or Inbox display styles 
(the sender’s name is initially in bold, but after clicking the note the bold is removed). 

Note: You can reply to all notes with the exception of public notes. 

To receive notes in the Chat style:  

When working in the Chat display style, all notes you send and receive are stored in the Notes 
transcript box and conform to the following color legend: orange for public notes sent to all 
attendees and blue for private notes sent to/received from participants.  



  Participant Application for PC User Guide 
 

Product Version: v9.5 
Published:  03/05/2013 47 

  
Figure 37–Chat Notes 

To send a reply to a private note, right-click on the note in the Notes transcript box and in the 
displayed popup menu, select Reply to Sender, or type Shift+R. Type your message and click 
Send.  

To receive notes as a Popup:  

You can receive a note that is displayed in a popup window.  

 
Figure 38–Popup Notes 

To send a reply, type your message in the My Reply box and click Send.  
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To receive notes in the Inbox style: 

If you are working with the Inbox display style, when you receive a note it is displayed in a 
similar way to that of an inbox in an email program, such as Outlook.  

Notes are listed in the upper pane according to the order in which they were received and 
display the sender’s name, type of note, and time received. By clicking a note, a preview of the 
note is displayed in the lower pane. To see the entire conversation, double-click the note. 

To send a reply, double-click the relevant note to display a popup window in which you can type 
a message, right-click the note and in the displayed popup menu, click Reply to Sender, or type 
Shift+R. Then, type in your message in the displayed popup window. You can also send a note to 
the host, presenter and co-hosts by selecting Host, Presenter, Co-Hosts in the To drop-down 
menu.  

 
Figure 39–Replying to a Note 

If the note is a public note sent by the presenter, you cannot reply to it.  

Removing Notes 
When working in the Inbox styles, a note can be removed by right-clicking it and selecting 
Remove This Note from the displayed popup menu.  

The same popup menu also enables you to remove all notes, or to remove only those notes that 
have already been marked as read. 

Saving Notes  
You can save all notes sent and received by you during the conference, as long as they were sent 
or received in the Chat display style. The notes are saved in .RTF format and can be saved in any 
location.  

To save notes:  

1. From the Conference menu, click Save Notes. This option is only enabled if you are working 
with the Chat display style. 

2. In the displayed dialog box, choose a location and then click Save. By default, the file is 
called Chat.rtf. 
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Defining Note Settings 
This section describes the various settings you can apply to notes, including the note display 
style. Note that as the presenter, or presenter in a conference, you can prevent participants 
from sending notes, as described in Disabling Notes. 

To define note settings: 

1. From the main menu, select Conference>Application Options. The Notes tab is displayed. 

2. In the Display Notes Tab section, select one of the following: 

• Inbox style: This displays incoming notes in a similar way to the inbox in an email 
program. Once selected, you can also define whether or not to delete a note after it has 
been read by selecting the Automatically remove Note from list after it is opened 
checkbox.  

• Chat style: This displays incoming notes, and your replies, in a chat format, similar to 
that experienced with any Instant Messenger program. Once selected, you can also 
define the text size of the chat session. 

Note that when either of the above options is selected, you can also define whether or not 
to display incoming notes in popup windows if the Notes tab is not currently in view (for 
example, when working in Enlarged mode), as described in the next step. 

3. In the Display Popup Notes section, select from one of the following: 

• Always: This displays incoming notes in popup windows, regardless of the style you 
selected in Step 2. 

• If Notes tab isn’t currently selected or visible: This displays popup notes if the Notes 
tab is not currently selected or visible. 

• Never: Popup notes are never displayed. 

4. In the Alert When New Note is Received section, select any of the following alerts: 

• Play a sound Always/Except if I am currently speaking/Never 
• Notes background turns light red 
• Flash ‘message light’ on Notes tab  

5. Click OK. 

Note: For screen reader users, it is recommended to use the Inbox style (select Inbox style 
in the Display Notes Tab section) not to display Popup notes (select Never in the Display 
Popup Notes section). 

Disabling Notes 
As the host or presenter in a conference, you can choose to disable the sending of notes 
between participants only, as well as disable the ability to send notes to the host.  
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To disable notes: 

1. From the Conference menu, click Conference Settings. The Conference Settings window is 
displayed. 

2. In the Policy section, select any of the following options: 

• Allow notes among participants—lets participants send notes to each other 
• Allow notes to presenter—lets participants send notes to the presenter 

The other options listed in this window are described elsewhere in this Guide. 

3. Click OK. 
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8. INSERTING FILES 

All conference participants (except for Phone-only participants, Web Participants, and users 
with a mobile phone) can insert files into the Conference Materials. All inserted files can be 
viewed in each participant’s Materials tab. Each file is validated and then converted, 
compressed and sent to the conference server and to all the participants in the conference. 

An online indication of the status of the inserted file is displayed, including whether all 
participants successfully received the file. The file can then be loaded, as long as you have 
Presenting rights.  

During the insert process, you remain connected to the conference with full functionality: 
incoming and outgoing sound, video, and application sharing should not be affected. 

Note: The file name cannot contain the following characters: 

~ ` ! @ # $ % ^ & * ( ) + = \ | ] [ “ : ; ’ ? / < > . ,  

Inserting a File 
The following procedure describes how to insert files into the Conference Materials.  

To insert a file during the conference: 

1. In the Materials tab, click Insert… 

–or– 

From the Whiteboard menu, click Insert Materials.  

–or– 

Drag and drop the relevant file from your computer to the Materials tab. Then proceed to 
Step 3. 

2. In the displayed Open window, browse to the relevant file and then click Open. Note that 
the size limit of the files to be inserted is defined by the Communications Center System 
Manager. The default is 10MB. 

Note: Only one file can be inserted at a time. 
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3. Depending on the file type, the file is validated and then converted to a format suitable for 
presentation on the whiteboard (see File Types for a list of file types and their compatibility 
with the insert process). 

Note: The conversion process is automatically performed (if the user has not defined 
settings otherwise, as described in the Inserting PowerPoint Files section), depending on the 
file type (see File Types). The file is converted to an image for presentation on the 
whiteboard. 

To convert a file, the relevant application associated with this file must be installed on your 
computer. During the conversion, the associated application may be activated and may even 
require some user input. 

If the file you are inserting contains a number of pages, each page is converted to a separated 
item (and named Page_1, Page_2, and so on). For large documents this may take a few seconds. 
When the conversion is completed successfully, the file’s pages are added to the Conference 
Materials and located immediately below the relevant file name in the Materials tab.  

 
Figure 40–Inserted File with Multiple Pages 

Note: A tooltip is displayed for each file, and its pages, indicating if the file is ready for 
presentation on the whiteboard. Any file still being uploaded to the server is indicated with an 
“Uploading” tooltip. For more information on these status tooltips, see Viewing the Status of a 
File. 

The files are then sent to the conference server and distributed to all the users currently 
connected to the conference. Whenever a user connects to the conference, the inserted files 
are sent to the user.  
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Viewing File Properties 
To view a file’s properties (the status of the inserted file), right-click on an item or folder in the 
Materials tab and in the displayed popup menu, click Properties.  

Note: Indication is also given when a file is still in the process of being sent, or if there were 
server problems that prevented the delivery of the file. In this case, you will be prompted to 
“Resend” the file. Alternatively, click More Info for further guidance. 

Resending Files 
To resend a file, right-click an item or folder in the Materials tab and in the displayed popup 
menu, click Resend. The sending process starts (compressing and sending) and the selected file 
is delivered to users that are currently connected to the conference and who did not receive the 
selected file. 

Note: This option is only enabled for files you originally inserted and that have already been 
uploaded to the server. 

Deleting Files 
To delete a file: 

Right-click an item or folder in the Materials tab and in the displayed popup menu, click Delete. 

–or– 

Select the file and press the Delete key.  

Notes:  

• You can select multiple files for deletion. 

• This option is only enabled for files you originally inserted and that have already been 
uploaded to the server. 

Viewing the Status of a File 
The status of an inserted file and its pages is displayed dynamically in the file/page tooltip. This 
tooltip is only displayed to the user who inserted the file. The following table details the various 
status tooltips. Note that there are differences between single page files and multi-page files.  
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Table 3–File Status 

Status Tooltip for 
Multi-page File 

Tooltip for 
Page/Single Page 
File/Unconverted 
File 

Comments 

Sending to 
Server 

‘Uploading’ ‘Uploading’ When sending process is initiated 
(compression and sending to server). 

Failed ‘Failed: x out of y 
pages are ready for 
presentation’ 

‘Failed’ When sending process fails 
(compression and sending to server),  
–or– 
When application is disconnected 
during sending to server. 

Completed ‘Ready for 
presentation’ 

‘Ready for 
presentation’ 

When distributing process is 
completed. All connected users 
received the inserted file (with or 
without errors). 

Unknown ‘Unknown’ None User that inserted the file was 
disconnected and reconnected. 

File Types 
The following table lists the majority of file types that are regularly included in Conference 
Materials and their compatibility with the insert process. 
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Table 4–File Types 

File Type File Extension Allow Online 
Insert 

Convert by Default 

Image BMP, JPG, JPEG, 
EMF, WMF, GIF 

Yes No 

Sound WAV, RMI, MID Yes No 

MP3 External file only No 

Movie AVI Yes No 

MPEG, MPG, 
WMV, MOV 

External file only No 

Link HTM, HTML Yes No 

PowerPoint  PPT, PPTX, PPS, 
POT, PTX, POTX 

Yes Yes  

Other SWF (Flash files) External file only No 

DOC, DOCX. DOT, 
DOTX, RTF, PDF 

Yes Yes 

XLS, XLT, XLC No No 

ASP No No 

All other file types No  No 

Recording VCR, VCS, VCM, 
VCQ  

Not permitted N/A 

Note: The range of file types supported by the insert process can be modified by your 
Communications Center administrator. 

Inserting PowerPoint Files  
When inserting PowerPoint presentations, they are converted to DHTML, and also include static 
image support for Web Participants. 

Inserting PowerPoint files as DHTML enables the following features: 

• The PowerPoint presentation is automatically resized to fit the whiteboard. 

• Presentations can be displayed in non-English languages. 

• Animation is supported  

Notes: 

• PowerPoint 2000, XP, 2003, 2007 and 2010 are fully supported, including animated 
presentations.  

• Some types of animation effects are not recommended for use because they either will not 
animate at all or the effect may not behave as expected: for example, effects that scale text 
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or objects in only one direction (for instance vertical, but not horizontal), such as Stretch, 
Swivel, Compress, Grow/Shrink, Spin, or Glide OR effects that rotate text, such as Flip, 
Spinner, Swish, Teeter, and Wave OR effects applied to charts (these effects will play as if 
they were applied to the chart as a whole and no parts will be animated) OR ‘dim after’ 
effects (these effects will not work for images (or video); if a Dim after effect is applied to an 
object the fill colors will dim but the outline color will not dim. 

To set how you want to insert PowerPoint files during the conference: 

1. From the Participant Application Conference menu, click Application Options. In the 
displayed Application Options window, click the Materials tab. 

2. In the Insert Documents during live Conference area, select the Send only images of the 
document’s pages, to view on the Whiteboard checkbox to enable the PowerPoint® insert 
options. 

3. Select from one of the following: 

• Dynamic images with static images (recommended): Inserts the PowerPoint file “as is” 
in DHTML format and adds a converted JPEG file for each slide. Select this option if you 
believe that some of the participants will be accessing the conference with the Web 
Participant Application or mobile application. 

• Dynamic images: Inserts the PowerPoint file “as is” in DHTML format. Select this option 
if you know that all participants accessing the conference have the latest Participant 
Application version installed and are not using the Web Participant or mobile 
application. 

• Static images: Inserts only JPEG files (converted from the PowerPoint slides into JPEG 
images). Select this option if you know that all participants will be accessing the 
conference with the Web Participant Application or mobile application. 

4. Click OK. PowerPoint files will subsequently be inserted according to the setting you 
implemented. 

Setting Inserted Files to be Opened Externally to the Whiteboard 
By default, files inserted by conference participants are automatically converted. This ensures 
their display on the whiteboard as images and not using their source application externally to 
the whiteboard. 

However, you can change this default setting to ensure that inserted files are not converted and 
instead opened externally to the whiteboard. This enables you to send files to all users that can 
be viewed and saved on their computers. To set inserted files to be opened externally to the 
whiteboard: 

1. From the Participant Application Conference menu, click Application Options and then click 
the Materials tab.  

2. In the Insert Documents during live Conference area, select the first option (Send the 
actual document itself and view it in a separate window…) and click OK. 
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9. USING EMOTICONS 

When communicating during an AT&T Connect conference, you can express yourself graphically 
using a range of emoticons. These emoticons are also displayed to the other conference 
attendees; each emoticon selected is displayed alongside your name in the Participants list.  

Note: Hosts can disable emoticons, together with requests to speak (from the Conference 
menu, click Conference Settings and then select the relevant options in the Policy section). 

To select an emoticon: 

1. From the Participants menu, click Choose Emoticon. 

2. Select the relevant emoticon. The selected button and appears “pressed” on the toolbar. 
This emoticon also replaces your icon in the Participants list. 

–or– 

Click the arrow to the right of the Raise Hand button in the toolbar. (This button is displayed 
by default though it is replaced by any emoticon selected.) 

 
Figure 41–Raise Hand Button 

In either case, a dropdown palette of emoticons is displayed. 
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Figure 42–Emoticons 

To cancel an emoticon: 

1. From the toolbar, click the selected emoticon. The button is replaced by the Raise Hand 
button, and your icon in the Participants list returns to its normal mode. 

–or– 

From the toolbar, click the arrow to the right of the emoticon you selected.  

–or– 

Choose Emoticon from the Participants menu. The dropdown palette of emoticons is 
displayed. 

2. Select Finish + <name of emoticon> at the bottom of the palette. This option is dynamic 
according to the emoticon selected and is not represented by an icon. For example, if you 
currently have the Applaud emoticon selected, the option will be displayed as Finish 
Applaud. 

The Raise Hand button is displayed again, and your icon in the Participants list returns to its 
normal mode. 

Note: Stepping out of the conference or receiving speaking/presenting rights will cancel any 
selected emoticon. In addition, the presenter can clear selected emoticons at any time. 

Stepping out of a Conference 
If you need to temporarily step out of the conference, for example, to answer an important 
telephone call, you can indicate to others that you are temporarily unavailable.  
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To step out of the meeting: 

1. From the Participants menu, click Step Out. 

–or– 

From the toolbar, click the Step Out button. 

 
Figure 43–Step Out Button 

Your icon in the Participants list is grayed out and the button toggles to Step In. 

 
Figure 44–Stepped-Out Participant Icon 

2. To rejoin the conference, click the Step In button. 

 
Figure 45–Step In Button 

Your icon returns to its normal mode, and the attendees are informed that you have 
rejoined the conference. 

 
Figure 46–Stepped-in Participant Icon 

Note: Stepping out of the conference will automatically cancel any emoticons you may have 
selected and also mute your microphone/telephone. 
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10. USING VIDEO 

AT&T Connect provides multi-point control video conferencing capabilities. Video is 
automatically activated once the host has the privilege of using video in the conferences. 
Participants with a webcam can start transmitting video any time during a conference.  

Notes:  

• If you are using the Web Participant application or a mobile application, you cannot transmit 
or view the video of other participants. 

• If you are recording the conference either locally or on the server, the recording does not 
include video. For more information on recording conferences, see Working with 
Recordings. 

Video Layout 
Video is displayed in All-Same-Size layout, in which participants view live-stream video of up to 
four participants in video windows of the same size: Small (176w x 144h) or Large (352w x 
288h). This layout is useful in interactive conferences, when most participants are expected to 
share information.  Participants can display the video stream in various views, as described in 
Changing the Video Pane View. 

 
Figure 47–All-Same-Size Layout 

For Hosts and Presenters 
The conference host can configure if, and how the participants view video during the 
conference. 
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Enabling or Disabling Video 
If the video feature was disabled for a conference, hosts can override this decision and enable 
video from within the conference, or vice versa. 

To enable or disable video:  

1. Click Conference Settings from the Conference menu to open the Conference Settings 
window. 

2. Check or uncheck Allow participants to use video. 

3. Click OK. 

Setting the Window Size 
If allowed by the administrator, hosts and presenters can set the size of the video windows as: 

• Small:  176w x 144h 

• Large 352w x 288h (CIF) 

Notes:  

• Because of its large bandwidth consumption, the Large layout is not available to all users by 
default, but only to organizations that enhanced their service to accommodate this layout. 

• If sharing data and video, it is recommended to select the small windows. 

To set the resolution of the Video window: 

1. In the menu bar, click on Audio/Video to open the Audio/Video menu. 

–or– 

Click on the arrow in the Video window to open the Video menu. 

 
Figure 48–Video Menu 
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2. Select Window Size and then select Small or Large. 

Participating in the Video Conference 
The following section explains everything participants need to know about participating in a 
video conference.  

Testing your Webcam 
Once your webcam is connected to your PC, you need to prepare for video conferencing by 
testing your webcam. Make sure your webcam is closed before you perform the following steps. 

Note: If you have more than one webcam connected to your computer, you can first choose the 
webcam you wish to use and then proceed to test it. 

To test your webcam: 

1. Select Test my Webcam… from the Audio/Video menu to open the Application Options 
window. 

2. In the Application Options window, click the Video tab. 

3. Choose the video capture device you want to use from the drop-down menu (in case you 
have more than one). 

4. Press Webcam Settings… to open the Camera Settings dialog box for defining your webcam 
settings, such as brightness, contrast and saturation. 

5. An example of a source dialog box is displayed below (the settings window is different for 
each webcam). 
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Figure 49–Camera Settings Window 

6. After defining your settings, click OK to return to the Application Options dialog box. 

7. Press the Test my Webcam button to check your video transmission. 

 
Figure 50–Test My Webcam Window 

8. Click OK and you are ready to start your video conference. 
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Notification in Participants List 
When you connect to a video conference, you see a webcam icon next to your name in the 
Participants list. You can also see other users who have a webcam connected. The webcam icon 
is enabled when users are transmitting video, and appears disabled when there is no video 
transmission. 

 
Figure 51–Enabled Webcam Icon 

 
Figure 52–Disabled Webcam Icon 

Starting or Stopping Video Transmission 
If you have a webcam, you can start transmitting video using the tool menu or toolbar option. 

To start transmitting video: 

• Click the My Video button on the toolbar. 

 
Figure 53–My Video Button 

–or– 

Select Start Sending My Video from the Audio/Video menu. 

Your video window opens and starts transmitting video. 

To stop transmitting video: 

• Release the My Video button on the toolbar. 

–or– 

Select Stop Sending My Video from the Audio/Video menu. 

–or– 

Select Stop Sending My Video from the Video menu on the video pane. 

–or– 

Click the Close button (X) in the top-right of the video panel or in the bottom of the video 
window, or select Close from the Video menu to close the window and stop transmission. 

–or– 

Uncheck Video from the View menu. 
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Stopping Video Transmission (Hosts or Presenters) 
A host or presenter can stop the video transmission of a specific participant at any time during a 
conference. 

To stop video transmission of a participant: 

• Click the Close button (X) in the upper-right corner of the video you want to close. 

–or– 

From the Video menu, click the participant whose video you want to close and from the 
menu, click Stop Video. 

Changing the Video Pane Position 
For your convenience, you can attach (dock) the video pane in three locations in your window—
top, left or bottom. You can then drag the video pane to different locations in your window.  

To dock the video pane manually: 

• Drag the video pane to the left, top or bottom of the window. 

The video pane attaches to the desired position. 

–or– 

Double-click the pane’s caption. 

The video pane attaches to the last docking position or to the left side (default). 

To dock the video pane via the Video menu: 

1. Select Attach from the Video menu. 

2. Select Left, Top or Bottom from the side menu. 

The video pane docks to the desired position. 

To float the video pane manually: 

Double-click the Video pane title bar and drag the Video pane to the desired location. 

–or– 

Hover your mouse over the Video pane until your cursor changes its shape and then drag 
the Video pane to the desired location. 

–or– 

From the Video menu select Move and then use the keyboard arrow keys to move the video 
menu to the desired location. 

To float (detach) the video pane via the Video menu: 

1. If the video pane is docked, select Detach from the Video menu. 
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2. Drag the video pane to any location you wish. 

Note: Selecting the Attach menu changes the video pane mode from floating to docked, and 
selecting the Detach menu, changes the pane mode from docked to floating. 

Changing the Video Pane View 
When using the All-Same-Size layout and in Floating mode, you can change the video pane view 
from Horizontal to Vertical to Grid.  

 
Figure 54–Grid View 

 
Figure 55–Horizontal View 
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Figure 56–Vertical View 

To change the video pane view: 

1. Select View… from the Video menu. 

2. Select Horizontal, Vertical or Grid from the side menu and the video pane is displayed in the 
desired view. 

–or– 

Click the “Switch view” buttons in the top-right of the video panel (to the left of the (X) 
button) and choose from the options below. 

 
Switches from Horizontal to Vertical 

 
Switch from Vertical to Grid 

 
Switches from Grid to Horizontal 

Viewing “Full Window” 
You can choose to view a specific participant in full window. 
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To view in full window: 

• Hover your mouse over the lower-left part of the video window to see the action buttons 
and press the button with the arrow pointing up to view the full window. 

 
Figure 57– Full Window Button 

–or– 

From the Video menu, click the participant’s name and then click View Full Screen from the 
menu. 

To view the window in the original size:  

• Hover your mouse over the lower-left part of the video window to see the action buttons, 
and press the button with the arrow pointing down. 

 
Figure 58–Original Size Button 

–or– 

Press the Esc key. 

Pausing and Resuming Video Transmission 
You can temporarily stop video transmission and go into paused mode. Then, whenever you 
choose, you can resume the transmission.  

Note: If you “step out” of the conference, your video also goes in the paused mode. For more 
information about stepping out of a conference, see Stepping out of a Conference. 

To pause video transmission: 

Hover your mouse over the video window to see the buttons at the bottom of the window and 
press the pause button. Your window goes into Paused mode. 

 
Figure 59–Pause Button 

–or– 

From the Video menu, click your name and then click Pause Video from the menu. 
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Figure 60–Video Window Buttons 

 
Figure 61–Paused Mode 

To resume video transmission after pausing: 

Press the button with the arrow pointing to the right to resume transmission. 

 
Figure 62–Resume Transmission Button 

–or– 

From the Video menu, click your name and then click Resume Video from the menu. 
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11. INVITING OTHERS TO JOIN THE 
CONFERENCE 

During a conference, you can invite others to participate in the conference. The invitation is sent 
by email.  

Note: This item is displayed only if your company allows this feature. 

To invite new Participants: 

1. Select Invite Others by Email… from the Conference menu. 

 
Figure 63–Invite Others by Email 

This opens an invitation to the conference with instruction on how to connect. 

2. Type the name(s) of the person(s) you want to invite in the To box, click Send. 
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3. If you are the host/presenter, you can invite other participants by phone. Select Invite 
Others by Phone… from the Conference menu to open a dialog box for entering the details 
of the persons you want to invite. 
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12. WORKING WITH RECORDINGS 

This section describes how to work with the Participant Application recording feature for 
recording conferences locally on your desktop and playing back recorded conferences. 

Note: For information on converting AT&T Connect recordings (VCM or VCR) to a standard 
format, see the “AT&T Connect® Recording Converter User Guide”. 

Recording a Conference Locally 
You can record a live conference on your desktop while you are connected to the conference 
(even if you are using a telephone) and play back the recording when you are disconnected.  

Note: The Recording menu commands are disabled if the conference host prohibited local 
recording when the conference was created. The server-side recording may also be unavailable 
if it was not enabled in the host account. 

This section describes how to make and save a recording of a live conference. 

To make a recording: 

1. From the Recording menu, select Start/Resume Audio and Web recording on Desktop. 

2. When the conference begins recording, all users get a notification message. This is relevant 
for local recordings and on servers. 

 
Figure 64–Recording Notification 

3. For users with phones, if a conference is being recorded, when users connect to the 
conference via phone, they hear the following message, “This conference is being 
recorded.” Otherwise they hear nothing. 

To stop a recording: 
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From the Recording menu, select Stop/Pause Audio and Web recording on Desktop. When the 
last recording in a conference stops, all users get notification that the recording has stopped.  

To save the recording: 

1. From the Recording menu, select Save Local Recording…  

2. In the displayed Save As window, choose a name and location for the recording session file 
(*.vcr) and click Save. 

Playing back a Local Recording 
To play back a recording saved on your computer: 

1. Open the Participant Application and select Playback Conference Recording…. from the 
Conference menu. 

2. Browse to the relevant file (in either .vcr or .vcm format) and click Open. Playback of the 
recording begins. 

Participant Window during Playback 
The Participant Application has a number of different features during the offline playback of a 
recording, as shown below. 

 
Figure 65–Participant Window during Playback 
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The Status Panel indicates playback of a recorded conference. The right-hand pane contains the 
Playback tab, which contains playback controls and a contents list for the recorded conference. 

Tip: To display the Participants list, go to the View menu and select Participants list. 

Note: When first playing back the recording, Playing Recorded Conference is displayed in the 
Status Panel. When someone is speaking during the recording, Listening is displayed. In 
addition, the name of the person speaking is displayed. The conference name is displayed in the 
application title bar if included in the recording. 

Playback Controls 
The Playback controls replace the regular toolbar during playback of a recording (although the 
full-screen icons remain).  

 
Figure 66–Playback Controls 
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The following control buttons let you control the recording: 

 
Figure 67–Playback Control Buttons 

Note: The Stop button takes you to the beginning of the recording. The Index buttons (the 
arrows with the vertical lines) let you easily navigate through the slides in a recording. These 
buttons can be used while playing the recording, with no need to stop or pause. Use the Index 
Forward button to move one slide forward in the recording and the Index Backward button to 
move one slide backward. 

Tip: The slider located below the playback controls can also be used for navigation (though you 
must stop or pause first). 

Closing the Recording 
Click the Close button (X) in the upper-right corner of the Participant window, or from the 
Conference menu select Exit to close the recording. 

Reviewing the Recording Contents 
The Playback tab displays the contents of the conference recording. You can jump to any of the 
displayed files by clicking the relevant file. For example, if you want to review a section of 
application sharing that you experienced, click the relevant section in the listed contents, as 
indicated by the application sharing icon. 

 
Figure 68–Appliction Sharing Icon 

The description in the Type column and the icon in the Content column indicate the type of 
content. 

Note: Polls that were visible when the conference was recorded will also be visible when the 
recording is played back: they will be displayed during playback in the same way that they 
appeared when they were originally recorded. However, tests and surveys will not be displayed 
when the recording is played back. 

You can also search the contents of the recording for a file name or text, as described in the 
following procedure. 

To search the recording: 

1. In the Playback tab, click Search Recording. 

2. Enter the relevant file name or text and click Find Next. The first file that meets your search 
criteria is automatically loaded.  
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13. RESPONDING TO POLLS 

As a conference participant, you may be prompted with any number of verbal questions that 
will require you to give a Yes/No or OK response, select an answer, or write free text. This 
section describes the various ways participants can respond to questions, polls and surveys 
initiated by the presenter. 

Responding to Verbal Questions 
When your presenter asks a question, you will be prompted for an answer and can respond by 
clicking a button either for OK or Yes/No in the displayed Respond to Poll window. Each 
participant’s response is registered in the presenter’s application. 

Upon completion of the question(s), the presenter can also choose to share the response 
statistics of all participants on the whiteboard (see Viewing Response Statistics). 

Note: Users using a smartphone or the Web Participant will not be able to receive the free-text 
question and thus cannot answer. 

Answering Non-Verbal Questions 
Your presenter can send a non-verbal question via the whiteboard during a conference. There 
are three types of non-verbal questions that the presenter can use: 

• Yes/No 

• Multiple-choice 

• Free text 

Upon completion of the question(s), the presenter can also choose to share the response 
statistics of all participants on the whiteboard (see Viewing Response Statistics). 

Answering Yes/No Questions 
You can answer Yes/No questions that your presenter sends you during a conference. 

To answer a Yes/No question: 
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In the Choose Answer area of the Question window, select either the Yes or No. 

Tip: You can refuse to answer the question by clicking the x button.  

Answering Multiple-Choice Questions 
You can answer multiple-choice questions your presenter sends you during a conference 

To answer a multiple- choice question: 

1. Select one of the answers (ranging from a minimum of 2 to a maximum of 5) displayed for 
the question. Use the arrows to scroll lengthy questions or answers. 

Note: Users using a smartphone or the Web Participant will not be able to receive the 
question and thus cannot answer. 

 
Figure 70–Multiple Choice Question Window 

2. Click Answer to send your answer to the presenter. 

Tip: You can refuse to answer the question by clicking Refuse. 

Answering Free Text Questions 
You can answer free text questions that your presenter sent you during a conference. 
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To answer a free text question: 

1. In the Enter Answer text box of the Question window, type in your answer to the question. 

 
Figure 71–Open Answer Window 

2. Click Answer to send your answer to the presenter. 

Tip: You can refuse to answer the question by clicking Refuse. 

Note: Users using a smartphone or the Web Participant will not be able to receive the question 
and thus cannot answer. 

Viewing Response Statistics 
Upon completion of the questions, polls or surveys, the presenter can choose to share the 
response statistics with the participants on the whiteboard. For more information, see Sharing 
Response Statistics. 

 
Figure 72–Participant Responses as Seen by the Presenter
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14. RECONNECTING 

If you are disconnected from the conference or from the Participant Application—don’t worry 
because in most cases, you can reconnect. 

Reconnecting to the Conference 
If you need to manually disconnect from the conference, you can reconnect as long as you have 
not closed the application. 

To reconnect to the conference: 

1. From the Conference menu in the Participant Application window, select Reconnect. 

2. Select one of the following options from the displayed sub-menu (these options are only 
available if you did not close the application): 

• Same Server as Before—automatically reconnects you to the conference using the 
server with which you last connected.  

• Automatically Select Best Server Available—automatically selects the server that is 
closest to you. 

• Manually Select Server—displays the Manual Server Selection window. To select a 
server on the list, double-click the server or click the server and then click OK. 

 
Figure 73–Manual Server Selection Window 
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Note: You can also reconnect by simply dialing in, according to the Dial-in instructions. 

Reconnecting to the Participant Application 
If you close the Participant Application (or are disconnected) and your phone is still connected, a 
message is displayed. Try reconnecting to the conference by following the steps in Joining a 
Conference. Alternatively, use the keypad characters on your phone (as described in Using your 
Telephone in a Conference) to communicate in the conference with your phone only.  
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15. REPORTING A PROBLEM 

Do you have a problem connecting to the conference or with the voice quality of the 
conference? Do you have a problem installing or using the Participant Application? The 
following sections explain how you can report these problems to the AT&T Support Center. 

Submitting a Telephony Ticket 
If you are having a problem with the connection and/or voice quality of a conference, you can 
open an online ticket during a conference in the Submit a Ticket window. After entering the 
details of your problem, the ticket is automatically sent to the AT&T Support Center and a 
confirmation email is sent back to you. 

To submit a ticket: 

1. Select Submit a Telephony Ticket from the Help menu. 

 
Figure 74– Option for Submitting a Telephony Ticket  

This opens the Submit a Ticket window in the whiteboard area of the Participant 
Application.  
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Figure 75–Submit a Ticket Window 

2. Enter the required information and click Submit. 

The AT&T Support Center will contact you to resolve the problem you are having with your 
connection or voice quality. 

Reporting an Application Problem 
You can report problems you may have with the Participant Application using the Log 
Submission Utility (LSU), a special application installed with the Participant Application. This 
application lets you send logs and other AT&T Connect data to the AT&T Customer Support 
team. The data helps the AT&T Customer Support team analyze problems with the application 
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on your environment, and helps to improve AT&T Connect products in future versions. Your 
personal information remains confidential and is not shared or used for purposes other than 
AT&T support. 

Automatic Activation 
In some cases, when the Participant Application encounters a problem, the LSU’s Report a 
Problem window automatically pops up, asking you to send a report. In such cases, all you need 
to do is describe the problem you experienced then click Send Report. 

 
Figure 76–Report a Problem Window 

Manual Activation 
You can manually open the Report a Problem window in one of the following ways: 

• From the Start menu, click Start>All Programs>AT&T Connect>Log Submission Utility. 
• From the Participant Application, click the Help menu>Report a Problem. 

Sending a Report 
1. Write a description of the steps you took before the problem occurred to help the AT&T 

support team analyze the problem (optional). 

2. Write a detailed description of the problem. 

3. Click Send Report. 
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Report ID 

The Report ID displayed at the bottom of the dialog is a random number that identifies your 
reports (this is the same number for all the reports you send).  

 
Figure 77-Report ID 

You need this number when contacting the Support team about your problem after sending the 
report. You can do one of the following when asked for this number: 

• Double-click the number to open an email message that is addressed to Customer Support 
with your Report ID. You can add additional details in the email message before sending. 

• Re-open the Log Submission Utility (as explained above) and provide Customer Support with 
your Report ID. 

• Select your Report ID (using your mouse) and copy-paste it to any other document you 
write. 

When the Send Operation Fails 

If the automated log submission failed, the LSU automatically copies a file to your desktop and 
issues the following email: 

 
Figure 78–Email of Log Submission Failure 

Do the following: 

1. Attach the file located on your desktop to the email message. 
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Note: The LSU displays the name of the file that you need to attach in the message body. 

2. Click Send. 

3. After sending the mail with the attachment, you can delete the file from your desktop. 

Reviewing the Collected Data (Optional)  
To review the collected data before sending: 

1. In the main dialog box, click Click here to view related information from the log file to 
display the following dialog: 

 
Figure 79–Window for Reviewing Data 

2. Click View related information from log files. 

3. Review the files 

Note: Windows Explorer will be opened automatically upon completion. 
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16. LEAVING THE CONFERENCE 

From the Conference menu, select Exit. You are first disconnected from the conference and 
then the application is closed 

–or– 

Click the Close icon in the top right corner of the Participant Application. 

Note: As an Audio-via-Phone participant, disconnecting your computer from the conference 
does NOT disconnect the telephone. However, in the displayed message upon disconnecting 
your computer, select to hang up your telephone if you want to disconnect your telephone from 
the meeting (this action disconnects your telephone from the conference server, regardless of 
whether or not you actually put your handset down). 

–or– 

If you are a Phone-only participant (you are connected to the conference with your telephone 
and not the Participant Application), hang up your telephone. 
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17. ADVANCED PARTICIPANT FEATURES 

This section describes additional AT&T Connect options not included in previous sections. 

The Application Options window, accessed from the Conference menu in the Participant 
Application menu bar, includes a wide range of options that enable you to modify how you work 
with the Participant Application.  

This section describes the more advanced of these options; to ensure compatibility with your 
organization’s network settings, and maximize the performance of the Participant Application.  

Note: The values for non-connection type parameters updated only take effect the next time 
the Participant Application is run. If the Participant Application is already running, you need to 
close it and run it again. 

To access the Application Options window: 

From the Conference menu, select Options. The Application Options window is displayed. 

Note: As this section only details a number of more advanced options, not all Application 
Options tabs are described here. Refer to other sections to view all tabs and options. 

Defining the User Interface Language 
You can specify the user interface language in the Others tab. The direction of text in the 
application is defined by the language selected from the Language dropdown list  

Defining Connection Protocol and Proxy Settings 
The Network tab contains the following Connection Protocol options and Proxy Server settings. 

Connection Protocol 
Select one of the following:   

• UDP + TCP—no tunneling. Participant Application uses UDP and TCP. 
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• TCP Only—TCP only. 

• Tunneling—selected by default. Enhanced tunneling option that can also be used if the “TCP 
Only” option failed and your environment supports SSL. 

Proxy Server Settings 
Select one of the following:  

• No proxy server—users exit the firewall without going through a Web proxy server. 

• Use proxy settings of Web browser—the Participant Application takes the Web proxy 
settings of the default browser to automatically locate the Web proxy server on the 
network. 

• Manual proxy settings—enable the Address and Port fields. Enter the IP address and port 
number for the Web proxy server. You can obtain these parameters from your system 
administrator. 

Defining Server Settings 
The Servers tab contains options in setting up Intelligent Server Selection (ISS) for the 
Participant Application. 

Intelligent Server Selection 
Select one of the following scan types: 

• Full—scan all servers to find the BEST performer 

• Fast—scan until a GOOD server is found 

• Full—scan, first time only 

Display Scan Results 
Select either a Basic or Detailed display of server data. 

Erase Prior Scan History 
Clicking the Erase Prior Scan History button erases the data from previous scan operations. 
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Defining Audio/Sound Settings 
This section describes how to define your audio and sound settings for live conferences, for 
conferences which allow using audio-over-computer. 

Define Sound Settings via Audio Setup Wizard 
You can define suitable sound settings for your microphone and speakers or headset (voice over 
computer) during a conference. These settings are not relevant if you intend to enter a 
conference with your microphone and speakers or headset. 

To change your sound settings: 

1. From the Audio/Video menu, select Audio Setup Wizard…. You are automatically 
disconnected from the conference (if connected) and the Audio Setup Wizard is displayed.  

 
Figure 80–Audio Setup Wizard Step 1 

Note: Before continuing with the wizard, close all other programs that play or record sound. 
You should also ensure that your speakers and microphone (or headset) are plugged in and 
switched on. 
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2. Click Next. In the displayed window, click the arrow button and set your volume level by 
adjusting the slider in the Speaker Volume area. 

  
Figure 81–Audio Setup Wizard Step 2 

3. Click Next. You can record a test message, up to 15 seconds long, to check how you sound to 
others. 

 
Figure 82–Audio Setup Wizard Step 3 

Tip: If you feel that the input level from your microphone is too low, check the Mic boost 
option. This option is not displayed if your sound card does not support it. 
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4. Click Next. You have successfully completed the wizard. 

 
Figure 83–Audio Setup Wizard Step 4 

5. Click Finish to save the settings you defined during the previous steps. You are automatically 
reconnected to the conference you were in before you ran the Audio Setup Wizard. 

Note: You can access this wizard at any time during a conference (unless you are using a 
telephone). 
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18. HOST, CO-HOST AND PRESENTER FEATURES 

This section describes additional AT&T Connect features for hosts, co-hosts and presenters only. 
The features deal with managing the conference, managing the participants and sharing on the 
whiteboard. 

Managing the Conference 
The following section describes host features for managing a conference, such as enabling 
Broadcast mode and recording a conference on the server. 

Enabling Broadcast Mode 
When in Broadcast mode, all participants are muted and locked except for the presenter, host 
and co-host. This layout is recommended for training and instructional meetings where there is 
one primary speaker at a time with limited interaction from the other participants. 

To enable Broadcast mode: 

• Click the Start Broadcast or Stop Broadcast button in the Participants menu.  

–or– 

From the main menu, select Broadcast Mode from the Audio/Video menu. 

• To selectively unmute an individual participant while in Broadcast mode, right-click the 
participant’s name in the Participants list and select Unmute and Unlock.  

• To selectively remove participants from the “broadcast group”, select Mute and Lock. These 
actions are also available from Participants menu>Actions on + participant’s name. 

Broadcast Mode and Video 

If you wish to enable video in Broadcast Mode, the host or presenter broadcasts a single video 
stream to all other participants in the conference.  For more information on video, see Using 
Video. 
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Figure 84–Video in Broadcast Mode 

Playing Entry and Exit Tones 
Entry and exit tones can be played for all users when a participant using a voice device enters 
and leaves a conference. When a participant joins the conference One beep is heard, and two 
beeps are heard when the participant leaves. 

If the host gets permission from the System Administrator to use entry and exit tones, the host 
can set this option before or during the conference. 

To set entry and exit tones before the conference: 

Dial in to your conference and change the future settings. 

To set entry and exit tones during the conference: 

1. Click Conference Settings from the Conference menu to open the Conference Settings 
dialog box. 

2. Check the Play entry/exit tones checkbox in the Policy section of the dialog box. 

Note: When connecting with a PC without an audio device, a tone is not heard. Changing 
this setting from the Conference Settings window is saved only for the current session. 

Starting without Host 
If the System Administration allows, the host can determine whether or not a conference can 
start without him/her.  

To allow the conference to start without the Host: 

Dial in to your conference and change the future setting. 

Continuing without Host 
Typically, conference calls end automatically when the host disconnects. However, if the System 
Administration allows, the host can determine whether or not the conference will continue after 
his/her departure, and until the last participant disconnects. The host can set this option before 
or during the conference. 

To configure the conference to continue without the Host before the conference begins: 
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Dial in to your conference and change the future settings.  

To configure the conference to continue without the host during the conference (is used only 
for the current conference): 

Check the Continue Without Host checkbox from the Conference menu. 

Inviting by Phone and Dialing Out 
The presenter can have AT&T Connect dial a number to establish an audio stream for the 
conference. For example: 

• To invite someone to participate in the conference using their phone.  

• To establish an audio link for an existing participant that joined using their computer, but 
not their phone. 

Use the Invite by Phone and Dial Out options to initiate a phone link to the conference. 

Note: Invite by Phone and Dial Out to participant may not be enabled in all systems. Check 
with your system administrator. 

To use Invite by Phone and Dial Out to start a participant audio stream: 

1. Do one of the following: 

• To invite a new participant, in the Participants main menu, select Conference> Invite 
Others by Phone. 

–or– 

Press the Participant’s button in the bottom of the Participants tab and select Invite 
Others by Phone. 

• For an existing participant, right-click a participant in the Participants list who does not 
have an audio stream and choose Dial Out to Participant. The Dial Out window appears. 

–or– 

From the Participants menu, select Actions on + participant’s name>Dial Out to 
Participant. 

2. Enter the phone number to dial, and click OK. AT&T Connect calls the number and prompts 
the speaker to join the conference. If the user accepts, their audio is automatically linked to 
the selected participant. 

Using a Billing Identifier (Optional) 
When joining a conference as a host, your account may have been set up with a billing identifier 
(ID). This optional billing ID lets you track conference call expenses for projects or clients. If your 
account was configured to prompt for a billing identifier, you are prompted to provide the billing 
ID when you join the conference, either by phone or PC. By phone, you enter the billing ID via 
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touchtone characters followed by a pound sign (#), and by PC via the Billing Identifier dialog box 
displayed below. 

 
Figure 85–Billing Identifier Window 

The billing identifier can be up to 20 alpha-numeric characters and a valid character set includes 
all characters with the exception of the following: 

• Pipe (|) 

• Right and left square bracket ([ ]) 

• Right and left squiggly bracket ({ }) 

• Circumflex aka caret (^) 

• Tab 

• Ctrl characters 

Using a Security Code 
An optional code lets the host secure his/her conferences. If the host account is set up with a 
security code, the host will be prompted to provide the security code to join the conference. The 
host can provide the security code from a phone or PC. 

All participants connected with the PC will be prompted to enter the security code. Participants 
using a previous version of the Participant Application (v.8.5) will be asked to upgrade their 
application. 

 
Figure 86–Meeting Security Code Window 
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Recording a Conference on the Server 
There are two types of server-side recordings: audio-only recordings, and audio and Web 
recordings. A host/presenter can start, stop, pause and resume the recordings on the server 
from the Participant Application. The host can then access the recordings and send them to 
users for easy playback.  For more information on viewing the list of recordings and sending 
them to users, see the “AT&T Connect™ myAT&T User Guide”. 

Note: These recordings are available if enabled on the host account. 

To start/resume and stop/pause a server-side audio and Web recording: 

1. Select Start/Resume Audio and Web recording on server from the Recording menu. 

2. To stop/pause a recording, select Stop/Pause Audio and Web Recording on Server from the 
Recording menu. 

To start/resume and stop/pause server-side audio recording: 

1. Select Start/Resume Audio-only Recording on Server from the Recording menu. 

2. To stop recording, select Stop/Pause Audio-only Recording on Server from the Recording 
menu. 

Changing the Conference Name 
Since hosts can send participants a link to recorded conferences from the myAT&T application, it 
is recommended to customize the conference name for tracking purposes. (By default, all 
reservationless conferences have the same name: host’s first name+last name+meetingroom 
number.) The host can change the conference name from the Conference menu, or the host will 
be prompted when starting an audio and Web server-side recording (if the conference name 
was not already changed). 

To change the conference name from the Conference menu:  

1. Select Edit Conference Name… from the Conference menu. 

2. Enter the new conference name in the Conference Name dialog box and press OK. 

To change the conference name when starting a recording: 

1. If you have not changed the conference name, select Start/Resume audio and Web 
recording on server from the Recording menu. A message is displayed asking if you want to 
change the name.  

2. Press Yes, enter the new name in the Conference Name dialog box and press OK. 

Playing back Audio and Web Server-side Recordings 
Hosts play back audio and Web server-side recordings from their myAT&T application. For more 
information, see the “AT&T Connect® myAT&T User Guide”. 
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Changing Conference Settings 
Hosts/presenters can control conference settings during the three types of conferences: 
iMeetings, eLearning conferences and Webinars.  

To change conference settings: 

1. Click Conference from the Conference menu. 

 
Figure 87–Conference Settings Window 

2. Check or uncheck the settings you wish to change and click OK. 

Ending a Conference 
The host or presenter can decide at anytime to end the conference.  

To end the conference: 

Select End Meeting from the Conference menu. The conference is terminated immediately and 
all users are disconnected. 

Managing the Participants 
The following section describes host features for managing participants in a conference, such as 
muting all participants and giving and taking presenting rights. 
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Muting and Unmuting All Participants 
The host or presenter can mute and unmute all participants any time during a conference. This 
feature is relevant for conferences in Voice Activated mode (not Broadcast mode). 

To mute and unmute all Participants: 

1. Click the arrow in the Participants’ menu to open the drop-down list. 

2. Click Mute All or Unmute All in the Participants menu. 

–or– 

Use DTMF signaling: *78 for Mute All and *70 for Unmute All. 

–or– 

From the Participants menu, click Actions on All>Mute All or UnMute All. 

The mute icon appears next to the names of the muted participants. 

 
Figure 88–Mute Icon 

Muting and Locking Participants 
The host or presenter can mute and lock the microphone of a selected participant. This 
participant will not be able to speak until the host unlocks his or her microphone.  

To mute and lock participants: 

1. Right-click the name of the participant whose microphone you want to mute and lock. 

2. Select Mute and Lock from the list of actions. 

–or– 

From the Participants menu, select Actions on + participant’s name/Mute or Unmute. 

Linking Unbound Participants 
“Unbound” participants are participants who attempted to enter the conference as an audio-
via-phone user and have somehow entered the conference as a phone-only user and a PC-only 
user, and are subsequently displayed twice in the Participants list. In this case, the presenter 
can link their computers with their phon. This action can be performed without any user 
involvement. 

To link unbound participants: 

1. In the Participants list, right-click on the relevant participant and click Link User’s Phone 
with Computer in the popup menu.  

–or– 
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From the Participants menu select Actions on + participant’s name>Link User’s Phone with 
Computer. 

2. In the displayed window, enter the name of the user you want to link the selected 
participant with. The list is sorted automatically according to what you enter. For example, if 
you enter only “g” the list automatically scrolls down to those participants whose names 
begin with “g”. 

3. Select the participant and click Link. In the displayed confirmation message, click Link 
Computer and Phone Now. The participant is now displayed only once in the Participants 
list. 

Note: To help PC users who have not yet bound their phone with the Participant Application, 
the application displays the “late linking” tooltip if audio was not connected after 90 seconds. 

Giving/Taking Presenting Rights 
Presenting rights may be passed from one participant to another so that participants can take a 
more active role in the conference. 

To give presenting rights: 

Right-click on the participant’s name in the Participants list and select Give Presenting Rights.  
 
      Or you can:

1. Click on the participant’s name in the Participants list and then click on the Participants 
menu. 

2. Select Actions on <participant’s name> and then click on Give Presenting Rights. 
“Presenter” is added to the name of the participant who was given the presenter rights. 

To take presenting rights: 

Right-click on the participant’s name in the Participants list and select Take Presenting Rights.
 
      Or you can:  
 
1. Click on the participant’s name in the Participants list and then click on the Participants 

menu. 

2. Click on Take Presenting Rights. 

Or you can: 

1. Click on the participant’s name in the Participants list and then click on the Participants 
drop-down menu in the Participants list. 

2. Click on Take Presenting Rights. 
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Renaming a Participant 
As the user with presenting rights, you can rename any participant that has joined the 
conference as a “Guest” Phone-user (relevant to “on the fly” users that could not be correctly 
identified as the Telephone User ID they entered is not recognized by the Communications 
Center).  

To rename a Participant: 

1. Ask the participant to identify himself/herself (alternatively, you may be able to recognize 
the participant’s voice). 

2. In the Participants list, right-click on the relevant participant and click Rename Participant 
in the popup menu. 

3. In the displayed Edit Participant Name window, enter a first and last name for the 
participant. 

–or– 

From the Participants menu select Actions on + participant’s name>Rename Participant. 

4. Click OK. The entered name is now displayed to all participants. 

5. Repeat as required (for example, if you made an error in Step 3). 

Note: The user’s updated name is also included in the conference attendance report. 

Expelling a Participant 
As the user with presenting rights, you can expel any other participant, including unknown users 
who have accessed a confidential conference or those who are behaving in a disruptive manner. 
Any expelled participant cannot re-enter the same conference. 

Note: The conference host cannot be expelled. Moreover, the conference host can expel a 
participant without the presenting rights. 

To expel a Participant: 

1. In the Participants list, right-click on the relevant participant and click Expel in the popup 
menu. 

–or– 

From the Participants menu>Actions on + participant’s name>Expel 

The expelled participant cannot reconnect to the conference by computer (if the participant 
uses the same email address) regardless of whether the conference is locked or not.  

2. To prevent other participants not already in the conference from trying to enter the 
conference, select the Lock Conference checkbox (or from the Conference menu, select 
Lock Conference) in the displayed warning message. 
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3. Click Yes to confirm the selected participant expulsion. The user is disconnected and a 
message is displayed informing them of their expulsion from the conference. The user’s 
expulsion will not prevent their access to other conferences. 

Note: The conference can also be locked by selecting Lock Conference from the Conference 
menu. 

Changing a Participant’s Role 
Hosts can change the role of participants in a conference, i.e., promote a participant to co-host 
and demote co-host to participant. A co-host can change the role of a participant to co-host only 
when the host is no longer in the conference, regardless of whether or not the co-host has 
presenting rights. 

To change the role: 

1. Right-click on the participant’s name in the Participants list. 

 
Figure 89–Change Role of Participant 

2. Click Change Role to and then click the participant’s new role. 

Clearing Icons 
You can also clear emoticons, poll responses, load indicators and highlighting on participants 
(found after searching) from the display.  

To clear: 

1. From the View menu, click Clear.  

―or― 

Click the Participants button to open the Clear menu.  
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Figure 90–Participants Button 

2. Do one of the following: 

• Select All to remove all emoticons, responses, load indicators and highlighting from all 
participants. 

• Select Emoticons to remove emoticons from all participants.  
• Select Responses to remove responses from all participants. 
• Select Load Indicators to remove load indicators from all participants. 

Managing Participants in the Hands Raised List 
Participants who have raised their hand to catch the host/presenter’s attention are 
automatically placed in a list. This list is accessible to the host/presenter upon clicking the arrow 
displayed automatically alongside the Hands Raised icon, as shown below. 

 
Figure 91–Number of Raised Hands 

From this list, the host/presenter can decide with which participant to perform a variety of 
actions, such as start a conversation or give remote control over an application.  

The participants are listed in the order in which they raised their hand. This can be especially 
useful in large conferences when the presenter is unsure of the order in which participants 
raised their hands. 

Note: Participants attempting to gain the presenter’s attention by clicking repeatedly on the 
Hands Raised toolbar button will automatically be removed from the list when they lower their 
hand, then added to the end of the list when raising their hand again. 

Sharing on the Whiteboard 
The following section explains everything you need to know about sharing materials on the 
whiteboard. 

Loading a File to the Whiteboard 
As a presenter, you can load the items displayed in the Materials tab to the whiteboard. For 
information on inserting files into the Conference Materials folder in the Materials tab, see 
Inserting Files.  
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To load a file: 

Right-click on the file in the Materials tab and click Load, or double-click on the file. The file is 
immediately displayed to all participants.  

 
Figure 92–Materials Tab 

Navigating and Loading a File 

You can also go through the materials in the order of the items by using the navigation buttons 
the lower left hand corner of the Materials tab. Each time you reach a different item using the 
navigation buttons, the item is displayed on the whiteboard.  

 
Figure 93–Navagation Buttons 

There is also a button for going back to the previously-loaded item, and for adding an 
annotation to the materials.  

To navigate materials without loading an item: 

Use the up and down arrows on your keyboard. 

Notes:  

• To define how you wish to load files (via a single or double click): In the menu bar, click on 
Conference> Application Options>Materials tab>Double click/Single click. 

• To set if you wish video files to automatically be played upon being loaded: In the menu bar, 
click on Conference> Application Options>Materials tab and then check Play video file 
immediately on load. 

Clearing the Whiteboard 
Hosts/presenters can clear the whiteboard’s contents at any time. 
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To clear the whiteboard: 

In the Drawing toolbox, click the Clear button to erase the whiteboard.  

 
Figure 94–Clear Button  

–or– 

From the Whiteboard menu, click Clear Whiteboard. 

Sharing an Application 
You can share any available Windows application installed on your computer. The participants 
will see the application on their whiteboards. While you work on the application, the 
participants can follow what you are doing on their own computers. 

In addition, you can transfer sharing to allow a single participant to work with the application, 
and at any time you can take back full control.  

To start application sharing: 

1. From the lower right pane in the Participant Application window, click the App Sharing tab. 

2. From the displayed list of applications currently running on your computer, select the one 
you want to share and click Start Sharing. 

–or– 

From the displayed list of applications, double-click the relevant application. 

The application is simultaneously loaded on the screens of all the participants in the conference 
and you can start working with it. Participants are informed that you are sharing an application 
with the following message displayed on the toolbar: 

 
Figure 95–Application Sharing by Presenter 

Any content previously displayed on your whiteboard is replaced by a message reminding you 
that an application is being shared. In addition, the Application Sharing Dashboard is displayed in 
the top right corner of the shared application. 

 
Figure 96–Application Sharing Dashboard 

The Application Sharing Dashboard enables you to perform a variety of actions without the need 
to return to the Participant Application window. For example, if a participant raises their hand, 
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you can ask if he/she has a question. Alternatively, you can select a participant to remotely 
control the shared application. 

See Working with the Application Sharing Dashboard for more information.  

Tip: You can select multiple applications to share at any one time. Only the currently active (in 
the foreground) application has the Application Sharing Dashboard displayed. 

Notes: 

• An application must be running on your computer before it can be shared. 

• Ensure that the shared application is in the foreground and not behind another application 
window. 

• Stop the application sharing whenever you do not need to work with it. Start again when 
needed. 

• All windows that have the same process as the shared application will be shared. 

To end application sharing: 

1. From the Application Sharing Dashboard, click To AT&T Connect. The Participant window is 
displayed. 

2. In the Application (App) Sharing tab, select the application and click End Sharing. 

–or– 

Load a file from the Materials tab. 

–or– 

Load a URL in the Web tab. 

–or– 

Use the hot key defined to end application sharing, as described in the Define a Shortcut Key 
to End Sharing section.  

 
Figure 97–End Application Sharing  
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Note: If you attempt to give another user presenting rights this will also stop application 
sharing. You will be prompted to confirm this is what you want to do. 

Working with the Application Sharing Dashboard 

When sharing an application, the shared application window will usually display in front of the 
Participant Application window. The Application Sharing Dashboard enables you to manage the 
ongoing conference session, while simultaneously working on the shared application. Only the 
‘sharer’ can view the Dashboard. 

Note: The Dashboard is displayed on the title bar of the shared application and cannot be 
moved (though it can be ‘minimized’). If the Desktop is being shared, the Dashboard is located 
in the top right corner. 

The following information/features are available via the Dashboard: 

• Minimize button 

• Mute button 

• Grant remote control 

• Indication of your volume level when speaking 

• The number of participants who have raised a hand to ask a question,  

• The number of notes 

• One-click option to return to the Participant Application window 

Minimizing the Dashboard 

The minimize button (with two arrows pointing to the right) toggles the display of the 
dashboard. This is especially useful when you want to temporarily hide the dashboard if it is 
obscuring content in the shared application window.  

 
Figure 98–Minimize Button 

To redisplay the dashboard, click the maximize button (with two arrows pointing to the left). 

 
Figure 99–Maximize Button 

Speaking while Sharing an Application 

Click the Mute button on the dashboard to start speaking. This button has the same functionality 
as Mute on the main toolbar, enabling you to use the microphone. 
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Reviewing Participant Feedback 

The middle section of the Dashboard is split into three sections, each of which indicates 
different feedback from the participants: 

• The icon with a number and a hand indicates the number of participants who have currently 
raised their hands. Click (or right-click) the icon to display a list of participants who raised 
their hands.  

 
Figure 100–Number of Participants Raising Hands 

• Select a participant and then select Allow>End Remote Control. If there are a number of 
participants, they will be listed in the order they raised their hands (the first participant to 
raise their hand is listed first). Note that this option is not available in Voice Activated 
conferences. 

• The icon with a number and a pencil indicates the number of notes sent in by participants. 

 
Figure 101–Number of Notes 

Note: Each time additional participants raise their hands, the feedback section of the Dashboard 
flashes for three seconds. To stop the flashing, click the Dashboard. 

Granting Remote Control to a Participant 

To grant remote control of the application: 

Click (or right-click) the face icon, select the relevant participant from the displayed list and then 
select Allow Remote Control. 

Note: Phone-only users do not appear in the list of participants. 

The selected participant has a mouse icon displayed (to the presenter only) alongside their 
name in the Participants list. 

 
Figure 102–Remote Control Icon 

The selected participant is informed that he/she has control of the shared application and a 
message is displayed on the toolbar (other participants will see the name of the person in 
control). 

 
Figure 103–Participant Control 
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To cancel remote control: 

Cancel the remote control of the application via the Participants list; right-click the participant 
and select End Remote Control from the popup menu. 

Displaying the Participant Application Window 

The To AT&T Connect button with the blue arrow displays the Participant Application window. 

 
Figure 104–Display Participant Application Button 

The application sharing session remains active, but the application sharing engine ceases to 
transmit any screen updates from the shared application, meaning participants will see a 
‘frozen’ image of the shared application (unless you are sharing the Desktop). Participants will 
not be aware that you have temporarily switched to the Participant Application: a message is 
therefore displayed on your whiteboard reminding you that the application sharing session is 
still in progress.  

To return to the shared application, click Go To after selecting the application to be shared from 
the list of Currently Shared Application(s) in the App Sharing tab. 

Sharing an Application “Over the Shoulder” 

While sharing an application, you may wish to work on the application with a participant. Or, a 
participant may request to work on the application with you. You can do this using the “over the 
shoulder” feature of the Participant Application and look “over the shoulder” at the participant’s 
desktop. While doing so, the other conference participants also view that participant’s desktop. 

Note: If a participant does not reply to the presenter’s request to view his/her desktop within 20 
seconds, the system automatically assumes that the participant has rejected the request. The 
presenter is informed that the participant did not respond to the request and will not be able 
view the desktop. 

To perform ‘Over the Shoulder’ with one participant and show to the rest of the conference 
attendees: 

Right-click the participant icon in the Participants list and click Start over the Shoulder to All. 
The rest of the conference attendees can see the participant’s desktop. 

–or– 

If the participant has raised their hand: from the application sharing dashboard, click the Raised 
Hand icon to display a list of participants who raised their hands. Select a participant and then 
select Start over the Shoulder to All. 

 
Figure 105–Number of Participants Raising Hands 
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–or– 

From the Participants menu select Actions on + specific participant>Start over the Shoulder to 
All. 

To stop “Over the Shoulder”: 

Right-click the participant icon in the Participants list, click Stop over the Shoulder. 

Defining Application Sharing Settings 
This section describes how to configure various application sharing settings. 

Define Output Bandwidth Control 

You can define the output bandwidth of your application sharing to suit the other participants’ 
connection. 

To define output bandwidth control: 

1. From the Conference menu, select Application Options. In the displayed Application 
Options window, click the Application Sharing tab.  

2. In the Output Bandwidth Control section, select the relevant mode from one of the 
following: 

• Normal: The default selection, this is relevant when you know that some participants 
use a fast connection. 

• High: Relevant when you know that all participants use a fast connection. 
• Low: Relevant when you know that all Participants are using a dialup connection. 

Customized: Select this option to enable the Settings button and define advanced 
application sharing settings, as described below. 

3. Click OK. 

Advanced Bandwidth Settings 

By selecting the Customized option from the Output Bandwidth Control list (see above), the 
Settings button is enabled. This option lets you define the bandwidth, as described in the 
following procedure.  

To define advanced bandwidth settings: 

1. Click Settings (after selecting the Customized output bandwidth option).  

2. Enter the bandwidth you wish to use (default = 256). 

3. Click OK to implement the above settings. 
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Define Image Quality 

You can set the image quality used in application sharing to assist in determining the bandwidth 
consumption.  

To define image quality: 

1. In the displayed Application Options window, click the Application Sharing tab.  

2. In the Image Quality section, define the following: 

• Max. quality: Define a percentage value using the arrows to increase/decrease your 
value. If there are no network connection issues, the image will be with Max. quality. 
Default: 80%. 

• Min. quality: Define a percentage value using the arrows to increase/decrease your 
value. If there are network connection issues, the image quality is reduced to the value 
defined. Default: 20%. 

• Note: The higher the value defined, the closer the quality to the original image. 
However, higher values come at the expense of additional bandwidth. 
If you have serious bandwidth issues and want to share a graphic intensive application, 
then you should reduce the “Min. quality” value. 

• Max. CPU usage: Defines the maximum CPU that the participant system process is 
allowed to use. By default, the value is set at 70%. It is recommended NOT to change 
this value as increasing/decreasing it may harm performance. 

3. Click OK. 

Define a Shortcut Key to End Sharing 

The presenter can define a shortcut key to end application sharing at any time. This enables the 
presenter to end application sharing quickly and easily and without the need to search for the 
Participant Application under a series of application windows.  

To define a shortcut key: 

1. In the Application Options window, click the Application Sharing tab.  

2. In the End Sharing Hot Key text box, enter the shortcut key combination that you wish to 
use to end application sharing. 

Tip: You can also define a shortcut key for ending other participant’s control over the shared 
application in the End Viewer Control Hot Key text box. 

Note: The shortcut key combination must include the Shift and/or Alt and any other keys. 
The Ctrl key is not supported. In addition, if you use a specific combination in other 
applications that you might want to share during a live session, you should not apply this 
combination as the shortcut key. 

3. Click OK. 
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Define a Shortcut Key to Set Focus on the Dashboard 

Participants can define a hot key to set the keyboard focus on the dashboard during application 
sharing. This option allows for keyboard access to the dashboard. The hot key will be active only 
when the participant is sharing an application and the dashboard is displayed in the top right 
corner of the shared application. 

To define a shortcut key: 

To set a hot key, click the key combination in the relevant edit box. The key combination must 
include Shift and/or Alt + any other key (the Ctrl key is not supported). The key combination 
should be unique and not used by the shared application.  

1. In the Application Options window, click the Application Sharing tab.  

2. In the Start/Stop Dashboard Focus Hot Key text box, enter the shortcut key combination 
that you wish to use for setting focus on the dashboard. 

Note: The shortcut key combination must include the Shift and/or Alt and any other keys. 
The Ctrl key is not supported. In addition, if you use a specific combination in other 
applications that you might want to share during a live session, you should not apply this 
combination as the shortcut key. 

3. Click OK. 

Display the Application Sharing Dashboard 

The presenter can determine whether the Application Sharing Dashboard is displayed or not 
when sharing an application.  

This option is particularly relevant for applications that do not have a title bar. When sharing 
these types of application, the Dashboard is displayed in the top right corner of the application 
window itself, obscuring some of the window’s contents and displaying a gray box to 
participants. The minimizing of the Dashboard may provide a temporary solution, but it is 
recommended to set the Dashboard not to be displayed to maximize the participants’ 
experience of the shared application.  

To define whether the Application Sharing Dashboard is displayed: 

1. In the displayed Application Options window, click the Application Sharing tab.  

2. In the Other section, deselect the Display Dashboard when sharing an application checkbox 
if you do not want to display the Dashboard. 

The setting is stored in the registry and remembered in subsequent sessions. Changing the 
setting takes effect immediately; it can be changed while an application sharing session is in 
progress, and immediately affects the display (or hiding) of the Dashboard on the shared 
application window. 
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Opening the Participant Window in Enlarged Mode 

You can define the Participant window to open automatically in Enlarged mode whenever an 
application sharing session is launched. 

To define the Participant window to open in Enlarged mode: 

1. In the displayed Application Options window, click the Application Sharing tab.  

2. In the Other section, select the Enlarge Whiteboard when viewing a shared application 
checkbox. 

The next time an application is shared, the Participant window is automatically expanded to 
the Enlarged mode. 

Initiating Questions, Polls and Surveys 
As a host or presenter, you can initiate open-ended questions, polls and surveys. You can also 
share the response statistics with all the participants. For information on how the participants 
answer these questions, polls and surveys, see Responding to Polls.  

When you initiate a poll, you can have the participants respond with “Yes” or “No”, or “OK”. 

To initiate a Yes/No or OK poll: 

1. After prompting the conference attendees with a verbal question, click the Polls tab, as 
shown below. 

 
Figure 106–Polls Tab 

2. A User Responses window is displayed, providing you with a live summary of user 
responses. 
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Note: A Respond to Poll window is also displayed: you can choose to respond, or ignore by 
closing the window. 

 
Figure 107–User Responses Window 

The User Responses window indicates the following: 

Participants that refused to respond or did not send a response are included in the Did not 
respond value.        

       The response values for each question are updated in real time. 

       The total number includes participants that have stepped out and those who were 
disconnected. 

3. You can also view individual responses in the Participants list (Yes=Y, No=N, OK=OK). 

 
Figure 108–User Responses in Participants List 

    Note: These responses are only visible to the presenter and are NOT displayed to any other 
participant. To clear these responses from the Participants list: from the, select 
Clear/Responses or Clear/All (which clears all emoticons, responses and load indicators). 

5. To cancel or stop the poll, click the same button as in Step 2. Poll in Progress is displayed 
alongside the polling buttons until you click the relevant button. 

6. You can also choose to share the responses displayed in the User Responses window, by 
clicking the Share button, as described in Sharing Response Statistics. 
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Initiating Single “On-the-fly” Questions 

This section describes how to initiate a single “on-the-fly” question, which can be free text 
(requiring participants to enter text), yes/no or multiple choice. 

To initiate a single question “on-the-fly”: 

1. From the Polls tab, click the Open Question button. The Prepare a Question window is 
displayed.  

 
Figure 109–Open Question Button 

 
Figure 110–Prepare a Question Window 

2. Select from one of the following: 

• Yes/No: After clicking OK, the Yes/No Question window is displayed. In the Title box 
enter the question name, in the Question box enter the question, and in the Correct 
Answer box, select Y or N.  

 
Figure 111–Yes /No Question Window 

• Multiple Choice: After clicking OK, the Multiple Choice Question window is displayed. In 
the Title box enter the question name, in the Question box enter the question, and in 
the Answers boxes, enter the answers (there can be 2-5 choices). Note that to use 
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choices 3, 4 and 5, you must select the relevant checkboxes on the left. In the Correct 
Answer box, select 1, 2, 3, 4 or 5. 

 
Figure 112–Multiple Choice Question Window 

• Free Text: After clicking OK, the Free Text Question window is displayed. In the Title box 
enter the question name, in the Question box enter the question, and in the Correct 
Answer box enter the correct answer. 

 
Figure 113–Free Text Question Window 

3. Click Send. The question is immediately displayed to participants and the User Responses 
window is displayed, from which you can monitor the responses. 
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Sharing Response Statistics 

You can share the responses statistics with all the participants and even save the shared 
statistics (and subsequently add it to Conference Materials for later use). The shared results are 
displayed on all participants’ whiteboards. You can also redisplay the previous response 
statistics (accessed from the View menu).  

To share response statistics: 

In the User Responses window, click Share. Note that you can share the response statistics at 
any time.  

The response statistics are displayed on all participants’ whiteboards.  

To save the response statistics: 

After clicking Share, and making sure the response statistics are displayed on your whiteboard, 
select Whiteboard>Save Whiteboard Content…. In the displayed Save as window, name the file 
and save it in the required location.  

Performing a Web Tour 
During a conference, if you have been granted presenting rights, you can conduct a Web Tour, 
which enables you to lead participants through a series of websites or other HTML pages. This is 
performed via the Web Tab in the Participant Application window. 

 
Figure 114–Web Tab 

There are two modes of operation for conducting your Web Tour: 

• Allow annotations: Enables you to add annotations to the displayed page. You cannot 
navigate the page, either through links on the page itself or via the scroll bars and Page 
Up/Page Down keys.  
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• Follow links when clicked: Enables you to navigate the links included on an HTML page. 
Annotations cannot be added in this mode.  

To perform a Web Tour: 

1. From the Web tab in the Participant Application window, type in the URL of the website you 
want to load and click Go. 

–or– 

Type in the URL and press Enter. 

The page is displayed on the whiteboard. 

2. Select the mode you want to implement for this page. 

If you select the Allow annotations mode, use the Drawing toolbox to write, draw and 
highlight items on the displayed page. Note that you cannot navigate any of the links 
included in the page. 

If you select the Follow links when clicked mode, navigate any of the links displayed on the 
page. You can also use the scroll bars and Page Up/Page Down keys, as well as the Forward 
and Backward buttons on the Web tab. Note that when selecting this mode, any 
annotations previously added to the HTML page are removed.  

Tip: Click the “X” button to abort the loading of a page. This button may be disabled if a 
browser other than Internet Explorer is used. 
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Appendix A: Glossary of Terms 

This section describes common terms that you may encounter as a participant:  

Application sharing 

A feature that lets participants view the presenter’s real-time interaction with a live application. 

Audio Conferencing 

Enables the use of standard telephones as audio devices in AT&T Connect conferences. Users 
can route conference audio through a standard telephone line or through their computer’s 
headset and microphone. 

Co-Host 

Co-hosts have the same privileges as the host. For example, drawing on the whiteboard and 
sending notes to all, and they are not muted in Broadcast mode. A co-host can also give and 
take presenting rights if the host leaves the conference. 

Communications Center 

The AT&T Connect Communications Center (ACC) is the gateway to your organization’s online 
conferences and training programs. 

Emoticon 

Participants can express their emotions graphically using a range of emoticons. All emoticons 
are easily accessible from the toolbar, while each emoticon selected is displayed to all other 
conference participants and presenters (alongside the participant’s name in the Participants 
list).   

Conference 

A term for conferences and conferences. 
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Conference Materials 

Material that can range from an individual PowerPoint slide to a combination of a complete 
PowerPoint presentation, pre-recorded audio or video segments, HTML links, image files, Office 
and other types of documents.  

Host 

The conference host. The host is often the presenter by default when the conference begins. 
The host can take back presentation rights at any time in the conference. 

Meeting Room 

A personal Meeting Room that is “always on”. There is no need to schedule Meeting Room 
sessions as with other Communications Center conferences; all that is required is a personal 
Meeting Room ID, which is used by conference hosts to access their Meeting Room at any time - 
and can easily be forwarded (via email or telephone) to others on any number of occasions.  

myAT&T 

An application installed with the Participant Application (and with its own desktop icon) that 
enables access to Meeting Rooms and Communications Centers, as well as other 
Communications Center conferences.  

Presenter 

The presenter is any participant who currently has “control” of a conference using the 
presenting rights. The first participant to enter the conference is automatically assigned 
presenting rights (not applicable to Phone-only users).  

Voice Activated Conferences 

Set by the presenter, this mode enables participants who want to speak to start speaking 
simultaneously at any point during the conference. Entry and exit from the speaking mode is 
automatic.  

Whiteboard 

A resizable workspace on the computer screen that functions similar to a blackboard in a 
conventional classroom. The whiteboard can be used live to load pre-prepared materials and 
pointer and drawing tools can be used to emphasize various elements in a conference. 

 



    

Product Version: v9.5 
Published:  03/05/2013 120 

Appendix B: Accessibility Information 

The AT&T Connect Participant Application is compliant with Section 508 of the US Rehabilitation 
Act. This section provides information on the features that make the Participant Application 
more accessible for people with disabilities. 

Keyboard Accessibility 
All actions in the Participant Application are keyboard-accessible. From the main menu you can 
either directly activate most of the actions in the application or move the keyboard focus to the 
relevant section of the application and then activate the relevant action from there. 

All menu commands can be accessed via the keyboard by pressing the ALT key, then pressing 
the first letter of the required menu’s name, or the underlined letter. You then navigate to the 
required command on that menu by using the up/down arrow keys or typing the first character 
of the command’s caption, or the underlined letter. 

To set the keyboard focus on any of the main sections of the application (such as the 
Participants tab, Notes tab, and so on): 

1. From the View menu, select Go to. 

2. From the Go to menu, select the desired section of the application (Participants Tab, Notes 
Tab, Materials Tab, App Sharing Tab, Web Tab, Polls Tab, Video Window, or Whiteboard). 

Once the keyboard focus is set on the desired section, you can perform tab navigation 
within the section. Each Go to option also has a keyboard shortcut. To see the full list of 
keyboard shortcuts, see Appendix C: Keyboard Shortcuts. 

Note: To use the whiteboard tools with the keyboard, you can select the relevant 
whiteboard tool from the Whiteboard menu, then from the View menu select Go 
to>Whiteboard and then use the mouse keys to navigate within the whiteboard.  

To set the keyboard focus on any of the open dialog boxes: 

1. From the View menu, select Switch Dialog Boxes. 

2. From the list, select the desired dialog box. 

–or– 
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Type ALT+9 to navigate between the open dialog boxes. 

To set the keyboard focus on the dashboard (during application sharing):  

1. From Conference menu, select Application Options. 

2. In the Application Options dialog box, select the Application Sharing tab. 

3. In the Hot Keys section, define a hot key for Start/Stop Dashboard Focus. For more 
information on how to define hot keys see Defining Application Sharing Settings. 

Once defined, clicking this shortcut during application sharing will set the keyboard focus on 
the dashboard. Clicking it again will bring the focus back to the shared application. 

For Presenters Using the Whiteboard 
For presenters who use the whiteboard for illustrations, shared files and shared applications, it 
is recommended to clearly explain what is being displayed on the Whiteboard, in order to assist 
visually impaired participants. 

Assistive Technology Tools 
The Participant Application supports Assistive Technology (AT) tools such as screen readers, 
screen magnifiers, and high contrast settings. 

Configuration Options for JAWS Screen Reader 
It is recommended to configure JAWS to use MSAA for listviews with the Participant Application. 

To set this configuration manually: 

1. Open the Participant Application configuration file in JAWS. The name of the file is 
student.jcf. 

2. From the configuration manager window, click the Set options menu and choose Advanced 
Options. 

3. In the Advanced Options dialog box, check the option Rely On MSAA For Listviews and click 
OK. 

4. Save the configuration file. 

To download the configuration file: 

1. Go to http://www.uc.att.com/support/JawsReader.html. 

2. Click the link to download the JAWS Configuration file for the myAT&T application. 

3. The file should be saved under the JAWS settings folder (go to the Windows Start menu>All 
Programs>JAWS>Explore JAWS>Explore my Settings><Language>). 

http://www.uc.att.com/support/JawsReader.html�
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Recommended Configuration and Features  
The following configurations are recommended for screen reader users  

Notes Options  
This configuration will assist screen reader users in receiving and reading notes more efficiently. 

To configure notes: 

1. From the Conference menu, select Application Options.  

2. In the Application Options dialog box, select the Notes tab. 

3. In the Display Notes Tab section, select Inbox Style. 

4. In the Display Popup Notes section, select Never. 

5. In the Alert when new Note is Received section, select the Always option for Play a sound. 

 
Figure 115–Accessibility Configurations for Notes 
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Application Sharing Options 
Keyboard users can define several hot keys that will assist them during application sharing. For 
more information, see Defining Application Sharing Settings. 

 
Figure 116–Defining a Hotkey 

Sound Alerts  
To allow visually impaired users to receive notification of a raised hand or a poll (other than the 
default visual notification), it is recommended to add sound alerts. 

To add a sound alert: 

1. From the Conference menu, select Application Options. 

2. In the Application Options dialog box, select the Others tab. 

3. In the Sound Alerts section, check the options, When a hand is raised and I’m the 
moderator and When a poll is sent or someone starts a conversation with me. 
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Figure 117–Sound Alert Options 

To receive sound alerts for received notes, see Notes Options. 

Conference Status 
Screen reader users can obtain a quick report on the status of the conference, such as the 
connection quality, who the speaker is, a recording indication and so on. 

To get a report: 

1. Click ALT+0. 

–or– 

From the Conference menu, select Application Options. 

2. Select Conference Status. 

A popup window that summarizes the conference status is displayed. The text of this dialog 
can be read by a screen reader. 
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Figure 118–Conference Status 
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Appendix C: Keyboard Shortcuts 

For accessibility purposes, you can carry out commands in the Participant Application using the keyboard 
instead of the mouse. The application supports standard Windows® keyboard navigation shortcuts as well as 
the following unique keyboard shortcuts. 

Table 5–Keyboard Shortcuts for Participant Application Online Help 

Shortcut Command 

ALT+0 Conference Status 

ALT+1 Go To Participants Tab 

ALT+2 Go To Notes Tab/Go To Playback 

ALT+3 Go To Materials Tab  

ALT+4 Go To App Sharing Tab 

ALT+5 Go To Web Tab 

ALT+6 Go To Polls Tab 

ALT+7 Go To Whiteboard 

ALT+8 Go To Video 

ALT+9 Switch Dialog Boxes 

SHIFT+R  Reply to Sender (from Notes Tab, Inbox Style) 
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Table 6–Keyboard Shortcuts for Participant Application Online Help 

Key Function 

1 Display the TOC 

2 Display the Index 

3 Display the Search Tab 

4 Go to the previous page 

5 Go to the next page 

8 Print the current page (equivalent to clicking the Print button in the toolbar frame). 

0 Shift the focus to the topic frame (equivalent to clicking within the topic frame). 
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	Figure 56–Vertical View
	1. Select View… from the Video menu.
	2. Select Horizontal, Vertical or Grid from the side menu and the video pane is displayed in the desired view.
	–or–
	Click the “Switch view” buttons in the top-right of the video panel (to the left of the (X) button) and choose from the options below.
	/
	Switches from Horizontal to Vertical
	/
	Switch from Vertical to Grid
	/
	Switches from Grid to Horizontal
	Viewing “Full Window”
	You can choose to view a specific participant in full window.
	 Hover your mouse over the lower-left part of the video window to see the action buttons and press the button with the arrow pointing up to view the full window.
	/
	Figure 57– Full Window Button
	–or–
	From the Video menu, click the participant’s name and then click View Full Screen from the menu.
	 Hover your mouse over the lower-left part of the video window to see the action buttons, and press the button with the arrow pointing down.
	/
	Figure 58–Original Size Button
	–or–
	Press the Esc key.
	Pausing and Resuming Video Transmission
	You can temporarily stop video transmission and go into paused mode. Then, whenever you choose, you can resume the transmission. 
	Note: If you “step out” of the conference, your video also goes in the paused mode. For more information about stepping out of a conference, see Stepping out of a Conference.
	Hover your mouse over the video window to see the buttons at the bottom of the window and press the pause button. Your window goes into Paused mode.
	/
	Figure 59–Pause Button
	–or–
	From the Video menu, click your name and then click Pause Video from the menu.
	 /
	Figure 60–Video Window Buttons
	/
	Figure 61–Paused Mode
	Press the button with the arrow pointing to the right to resume transmission.
	/
	Figure 62–Resume Transmission Button
	–or–
	From the Video menu, click your name and then click Resume Video from the menu.
	11. Inviting Others to Join the Conference
	During a conference, you can invite others to participate in the conference. The invitation is sent by email. 
	Note: This item is displayed only if your company allows this feature.
	1. Select Invite Others by Email… from the Conference menu.
	/
	Figure 63–Invite Others by Email
	This opens an invitation to the conference with instruction on how to connect.
	2. Type the name(s) of the person(s) you want to invite in the To box, click Send.
	3. If you are the host/presenter, you can invite other participants by phone. Select Invite Others by Phone… from the Conference menu to open a dialog box for entering the details of the persons you want to invite.

	ATT_Connect_Participant_UG_v.9.5_IE_734.pdf
	From the Recording menu, select Stop/Pause Audio and Web recording on Desktop. When the last recording in a conference stops, all users get notification that the recording has stopped. 
	1. From the Recording menu, select Save Local Recording… 
	2. In the displayed Save As window, choose a name and location for the recording session file (*.vcr) and click Save.
	Playing back a Local Recording
	1. Open the Participant Application and select Playback Conference Recording…. from the Conference menu.
	2. Browse to the relevant file (in either .vcr or .vcm format) and click Open. Playback of the recording begins.
	Participant Window during Playback
	The Participant Application has a number of different features during the offline playback of a recording, as shown below.
	/
	Figure 65–Participant Window during Playback
	The Status Panel indicates playback of a recorded conference. The right-hand pane contains the Playback tab, which contains playback controls and a contents list for the recorded conference.
	Tip: To display the Participants list, go to the View menu and select Participants list.
	Note: When first playing back the recording, Playing Recorded Conference is displayed in the Status Panel. When someone is speaking during the recording, Listening is displayed. In addition, the name of the person speaking is displayed. The conference name is displayed in the application title bar if included in the recording.
	Playback Controls
	The Playback controls replace the regular toolbar during playback of a recording (although the full-screen icons remain). 
	/
	Figure 66–Playback Controls
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